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or more than a decade, Director

has set the standard for multime-

dia development. In fact, Director

was the first multimedia author-

ing tool to combine animation

with a scripting language so that devel-

opers could create interactive presenta-

tions, games, or computer-based training

courses. It was also the first product that

allowed authors to create multimedia

content that could be deployed to both

Mac and Windows (prior to this cross-

platform innovation, developers literally

had to double their work to reach both

users).

With numerous innovations, Director

has made an incredible impact in the mul-

timedia industry. By the mid-1990s more

than 70% of all multimedia CD-ROM titles

were produced with Director. In 1996,

Director fundamentally changed the way

users experienced the Internet with the

introduction of Shockwave Player, which

brought multimedia to the Web. 

Director MX 2004 continues to build

on its history of innovation. As a member

of the Macromedia MX 2004 family of

products, Director now offers more

power, a tighter level of integration with

MX 2004 products, and a more stream-

lined and efficient workflow. 

Power is about being able to incorpo-

rate whatever media helps you get your

message across: audio, video, graphics of

all sorts. Director supports more than 40

different media types, and in this release

we’ve added the ability to use Windows

Media and DVD-Video in Director proj-

ects. 

Even if the media is not natively sup-

ported, you can still use it through

Director Xtras (extensions). Hundreds of

Xtras are available to take your projects

in whatever direction you choose. For

instance, if you want to add joysticks to a

kiosk-based project or change the users’

screen resolution, Xtras give you the

power to do it. 

With Director, power also means the

ability to embed, control, and play back

DVD movies within your projects. You

now have the ability to create cross-plat-

form, enhanced DVD content. That

means Director is a great companion

application for people creating DVDs

with tools like DVD Studio Pro and Adobe

Encore. You can take the DVD projects

that you’ve created with those applica-

tions and bring them into Director, where

you can add additional interactivity and

media types for an enhanced DVD-ROM

viewing experience. 

We know that many customers use

Director and Flash together. Why?

Because using them together is more

powerful than using them alone. If you’re

a Flash user, Director will allow you to

extend Flash content beyond the brows-
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er. You can reuse your Flash content

inside Director and rapidly develop appli-

cations that leverage Director’s broad

media support, advanced memory man-

agement, interactive 3D, and authoring

and runtime extensibility.

In Director MX 2004, developers can

now import Macromedia Flash MX 2004

files and take advantage of the perfor-

mance enhancements found in that

release. Those enhancements – com-

bined with performance work we’ve

done in Director related to how we han-

dle Flash files – mean that your Flash

assets will perform better than ever. 

We’ve also added Director-certified

Flash components to the application, so

that Director developers can get basic

tasks done quickly.

In addition, we’ve updated the user

interface to take advantage of MX 2004

workflow improvements, such as an inte-

grated reference panel and start page.

Plus, we’ve added Director-specific

enhancements, such as a dockable Stage

and dockable Movies in a Window. You

can even customize your panel sets and

create windows that are irregularly

shaped, letting you create executables

that are shaped like stars, donuts, trian-

gles, or whatever shape you can imagine. 

For the first time in the history of

Director we’ve added an industry-stan-

dard scripting language to the product, in

addition to Lingo. This language will bring

Director to audiences who are already

skilled with scripting languages and want

to broaden their skills into Director. 

We’ve added JavaScript syntax.

Developers can use one or both, or a com-

bination of the two. Web developers can

easily leverage their existing knowledge to

achieve immediate results in Director. Lingo

programmers can also collaborate with

experienced JavaScript coders and seam-

lessly use both scripting languages in the

same project to reduce development time.

We’re very excited about the possibilities

this new scripting language affords our

users. And for those who use Lingo, we’ve

made some updates to Lingo dot-syntax

that will help them code more efficiently.

Another exciting new feature is our

publishing panel. The publishing panel

lets developers create cross-platform pro-

jectors or Shockwave content for Mac

and Windows with a single click. And it

lets users save settings, so that they can

publish projects much more quickly. 

Finally, we’ve included something

very techie-sounding but extremely well

received from our beta testers: sprite and

channel naming. This feature

means it’s much easier to make

last-minute changes to your proj-

ects. 

Whether you’re a professional

multimedia developer; a Flash user

wanting to add different media

types or deploy content to CD; an

e-learning professional, game

developer, or DVD professional,

you should check out the latest

release of Director. You won’t be

disappointed.
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’m not one who normally tries to

predict the future. I ignore stock

market tips, advice from psychics,

and weather reports. But I think I can

safely say that 2004 will see some of the

most fundamental changes in Web-site

design since the birth of Netscape

Navigator. This is the year of CSS.

Sure, Cascading Style Sheets isn’t a new

technology – the original recommendation

came out in 1996. And if you’ve been build-

ing sites for the last few years, it’s likely

you’ve been taking advantage of the for-

matting control CSS offers – from typo-

graphic nuances like line-height and text-

indent, to fine-tuned background, border,

and margin controls. But odds are, for your

most important sites, you’ve steered clear

of CSS layout and stuck with the tried-and-

true Web-layout workhorse – HTML tables. 

The problem isn’t CSS – the standard is

robust enough to handle most design

challenges. It’s the browsers that we (or

our bosses and clients) feel compelled to

support; we fear that some vocal minority

of our Web traffic still clings to Netscape

Navigator 4, or Internet Explorer 3. (Please

check your Weblogs! It just ain’t so.)

But the dam is finally cracking. The

groundbreaking work of CSS Zen Garden

(www.csszengarden.com) has shown that

CSS provides a level of design control that

(in the right hands) can rival the best layout

that print publications can offer. And it’s not

just personal Web zines, blogs, and “experi-

mental”sites that are adopting CSS. Major

corporations have seen the light and are

following along – Wired.com, ESPN.com,

FastCompany.com, and even AOL.com are

using pure CSS on some if not all of their

sites’pages. Yeah, that’s right: AOL.

From a business perspective there’s a

lot to admire about CSS. In most cases, it

can trim significant fat from table-heavy

HTML files – meaning faster pages and

lower bandwidth costs. ESPN.com, for

example, estimates that they’ve shaved

50KB from the average page on their site,

leading to a projected bandwidth savings

of 2 terabytes of data per day. Amazingly,

their home page (http://msn

.espn.go.com) is still a visual feast of

graphics and fine design details.

In addition, CSS-based designs pro-

vide great flexibility in site updates – a

single CSS file can skin an entire site.

Swap one CSS file for another and you

can instantly change a site’s look and feel

– check out www.csszengarden.com to

see this amazing feat in action.

Fundamental changes to a layout – such

as moving the navigation bar from the

top of the page to a left-hand sidebar –

require changing only a few CSS rules, not

hours of tedious reworking of HTML code.

The original benefits of Cascading Style

Sheets remain as well: CSS encourages

modular design and the separation of struc-

ture (HTML) from presentation (CSS); output

can be customized to a wide variety of

devices so content is accessible by printers,

screen-readers for the visually impaired, cell

phones, PDAs and other hand-held devices,

and even text-based Web browsers like

Lynx; and for designers, the most important

benefit of CSS is that it just looks better than

anything you can do with HTML alone. 

CSS isn’t a Macromedia technology, but

everyone developing Web sites with

Macromedia tools can feel its impact. Even

Flash MX 2004 provides some support for

CSS to provide more unified presentation

between Web pages and Flash movies.

And, of course, Dreamweaver users and

ColdFusion developers can take immediate

advantage of CSS in their workflows. In fact,

the most significant additions to

Dreamweaver MX 2004 relate to CSS – from

better style creation and editing to greatly

improved rendering of CSS designs within

Dreamweaver. That’s why in the next few

months we’ll present a variety of articles on

CSS in the Dreamweaver section of MXDJ.

We’ll cover the basics of CSS, as well as

troubleshooting advice, advanced tips, and

tricks – information you’ll need to stay

ahead of the curve. Enjoy the future. 

Dave McFarland is the Dreamweaver edi-

tor of MX Developer’s Journal and author

of Dreamweaver MX 2004: The Missing

Manual. davemcfarland@sys-con.com
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Your Workflow in
Dreamweaver

Dreamweaver attracts many types of

developers and designers by its very

nature. The program appeals to designers

because of the real-time rendering of the

HTML and server-side code in Design

view. The program appeals to hand-

coders because it allows you to type code

in Code view without worrying about the

program changing your code. The pro-

gram appeals to Web application devel-

opers because it combines hand-coding,

quick application development using

built-in behaviors and server behaviors,

and offers plit Code/Design view for easy

access to all aspects of your page. 

The workflow for these developers

will vary widely. A hand-coder may never

use a behavior or server behavior, and

never even open Design view. A person

who works in Design view may never edit

code by hand. 

Different developers have different

types of workflow, but the concept of the

server behavior can fit into anyone’s

workflow. This is why: when you build

your own server behavior, you are using

your code. You aren’t using some code

written by Macromedia, or someone

else’s idea of how a particular function or

section of code should be written. It is

your code, packaged into a point-and-

click interface that can be inserted into a

document quickly and accurately. You

can click a button faster than you can

type, copy, or paste. Any code that you

find yourself using more than once

makes a good candidate for a server

behavior. 

Isn’t a server behavior just like a code

snippet? In a way it is, but it is also much

more than that. Server behaviors are

handy because they are packaged func-

tionality. They exist for the sole purpose

of speeding up the development process.

One aspect of server behaviors that

makes them so useful is that they can

consist of more than one code block –

often in different parts of your page. For

example, if you have a piece of code that

generates the recordset, opens a file on

the server, attaches the file to an e-mail,

sends the e-mail, and then closes a

recordset, you might be looking at three

or four blocks of code. You can put the

whole thing into a server behavior and

save the hassle of inserting separate snip-

pets or copying/pasting blocks of code

into your page.

The other aspect of server behaviors

that truly separates them from the code

snippet or the copy/paste method is that

they can be parameterized. The parame-

ters can be typed in or you can use any of

the built-in Dreamweaver controls, such

as browse buttons for files; buttons for

database fields; or dropdown lists of con-

nections, database tables, or fields. The

advantage here is that you can allow

Dreamweaver to choose an item so that

you don’t risk mistyping a field name, or

need to calculate relative paths to docu-

ments and images.

Now that you know why you should

build your own server behaviors, let’s get

down to building one. Because

Dreamweaver supports a wide variety of

server environments, I’ll show the code

for each of the server environments that

you can use with Dreamweaver.

Building a Server Behavior
Not much skill is involved in building

server behaviors. The biggest hurdle is

changing your workflow to incorporate

the Server Behavior Builder (SBB) into it.

To build one, you need to know only two

things: the code you want to insert in the

page, and where you want to insert it.

The Server Behavior Builder does the rest

for you, with its wizard-like interface.

After you’ve built the server behavior, it

will be available to you from the Server

Behaviors panel.

The SBB is located in the Server

Behaviors panel. To access it, click the

plus sign (+) on the panel and then click

New Server Behavior (see Image I). This

will open up the builder. To get the ball

rolling, we’ll create a very simple server

behavior that redirects a user to a differ-

ent page if a session variable is not equal

to a specific value. Use Code I for the

server model of your choice to complete

the example. For the examples I’m going

to assume that you already have a site set

up in the server model of your choice.

After clicking New Server Behavior,

you are presented with the dialog box in

Image II. Follow these simple steps to cre-

ate the server behavior.

1. Pick the language your page uses

from the dropdown list. The drop-

down list should already be show-

ing the server language of your

page, but if it isn’t, choose it.

Dreamweaver supports these lan-

guages:

- ASP/JavaScript

- ASP/VBScript

- ASP.NET VB

- ASP.NET C#

- PHP MySQL

- ColdFusion

- JSP

2. Give your server behavior a name.

Call this one “Redirect On Session

Value”. The hardest part of building

a server behavior is giving each

server behavior a unique name that

is 27 characters or less, and make it

meaningful to you.

3. Click OK to move to the next dialog

box, shown in Image III. Here is

where you will add the code for

your server behavior. So far, creat-

ing the server behavior has been a

lot like creating a snippet.

4. Click the plus sign to insert a new

code block. The code block will

have an arbitrary name, like

“Redirect On Session _block1”,

which you can accept by clicking

OK or change it to something else.

In most cases, the default name is

fine, as it is a name that

Dreamweaver will use internally to

keep track of the code blocks. The

only consideration is that the name

has to be less than 26 characters if

you want to package your server

behavior. Unfortunately,

Dreamweaver does not enforce this

internally. In this case, remove all

the spaces so that it reads

im
a

g
e

 I
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image IV

“RedirectOnSession_block1”. That

will make the name 24 characters.

Click OK to accept the name.

5. Next you can paste your code into

the Code Block box. The box will

have some generic text in it to

begin with that says “Replace this

text with the code to insert when

the server behavior is applied”. This

is exactly what you should do. Paste

the code from Code I into the box.

6. In Code I notice that the code has

three items that can be variables:

the name of the session variable

(SessionVarName), the value that

you want to match (ValueToMatch),

and the page that you will be redi-

recting the visitor to

(PageToRedirect). Replace these

now by highlighting each word in

turn, then clicking the Insert

Parameter In Code Block button.

That brings up the dialog in Image

IV.

7. The name of the parameter should

be changed from the generic

“Param1” to something meaningful.

In this case, the name you use will

show up in your final server behav-

ior interface. Type “Session Variable

Name” for the first parameter,

“Value To Match” for the second

parameter, and “Page To Redirect

To” for the third parameter. Notice

that Dreamweaver inserts two @

symbols around your parameter

(@@Session Variable Name@@).

Dreamweaver uses this pattern

internally to replace your parame-

ters.

8. Choose where you want the code

inserted. There are several options

here, but we’ll choose “Above the

HTML Tag” under the Insert Code

option, and “The Top of the File”

under the Relative Position option.

9. Click the Next button to move to

the next section, where you will

create the interface for your server

behavior. You can use plain text

fields for the Session Variable Name

and Value To Match fields, but

choose the URL Text Field for the

Page To Redirect To field (see Image

V). This will place a browse button

next to the field so that you can

choose a file in your site.

Dreamweaver will calculate the rel-

ative paths.

10. Click OK to complete your first serv-

er behavior. It will show up now in

the Server Behaviors panel. 

Choose the new server behavior

“Redirect On Session Value” from

the panel to see the interface you

just created. It should look like

Image VI. If you fill in the values and

apply it to the page, the code will

be inserted at the top of your page.

A More Complex 
Server Behavior

The first server behavior was really

basic, to get your feet wet with the

SBB. Now we’ll add a slightly more

complex server behavior to your

collection. This code will work with

a search/results page, giving you a

keyword highlight on your search

word. The code has to be versatile

enough to recognize the case of

the letters in the search word. For

example, if you type “ColdFusion” or

“coldfusion” you want the word to

be highlighted in the search results

using the same case as appears in

the text rather than using the case

that was typed in the box. Code II

will accomplish this.

To build this server behavior we’ll

follow the exact same steps as

before, only this time we have two

code blocks to add to the server

behavior. The first code block will

be a function that is added to the

top of the document (with no

parameters) and the second block

will be added at the current cursor

location and will replace whatever

is selected. We’ll use this to display

a recordset field – with the function

call already in place. 

Following are the steps to build

this server behavior:

1. Choose New Server Behavior from

the Server Behaviors panel.

2. Pick the language that your page

uses from the dropdown list. 

3. Give your server behavior a name.

Call this one “Highlight Search

Word”. 

4. Click OK to move to the next dialog

box.

5. Click the plus sign to insert a new

code block. The code block will

image II

image III

Tip: One of the first things you

should learn about building server

behaviors is that you want your

code to be solid and completely

debugged before you build it as a

server behavior.
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have an arbitrary name. Click OK to

accept the name.

6. Next, paste the code from Code II

into the Code Block box. Start with

Block 1. This block has no parame-

ters.

7. Click the plus sign to insert a new

code block. The code block will

have an arbitrary name. Click OK to

accept the name. This is Block 2.

8. In Code 2, Block 2, the code has

three things that will be variables:

the name of the recordset (rs), the

recordset field (field), and the

search field name (searchfield).

Replace these now by highlighting

each word in turn, then clicking the

Insert Parameter In Code Block but-

ton.

9. Type “Recordset Name” for the first

parameter, “Field” for the second

parameter, and “Search Field” for

the third parameter. 

10. The next step is to choose where

you want the code inserted. You will

have to choose a position for each

code block. Choose “Above the

HTML Tag” under the Insert Code

option, and “The Top of the File”

under the Relative Position option

for the first code block (the func-

tion). Choose “Relative to the

Selection” and “Replace the

Selection” for the second code

block.

11. Click the Next button to move to

the next section, where you will cre-

ate the interface for your server

behavior. Using the arrows, move

Recordset Name to the top

and Field to the second posi-

tion. 

12. Choose Recordset Menu for

the Recordset Name parame-

ter, Recordset Field Menu for

the Field parame-

ter, and leave the

Search Field

parameter set to a

plain text field.

Your server behav-

ior interface will

now show a drop-

down list of all recordsets on the

page, and after the user chooses a

recordset, it will show all fields in

that recordset.

13. Click OK to complete the server

behavior. It will show up now in the

Server Behaviors panel.

Using the Server Behavior
Now let’s set up a page where you can

use this new server behavior. The basic

structure of a search/result page is to have

a search box and button, a recordset, and

a dynamic table that displays the results.

To set this page up, we’ll use some built-in

Dreamweaver server behaviors (using a

sample database of your choice). We’ll

build the entire page from Design view.

1. Build a form on your page using a text

field and a submit button. The easiest

way to do that is to open the Form tab

of the Insert bar and click the follow-

ing three buttons in turn: Form, Text

Field, Button. Give your text field the

name searchfield and set the method

of the form to GET.

2. Add a recordset to your page that is fil-

tered by the text field. A recordset can

be added from either the Bindings

panel or the Server Behaviors panel,

among other places. For this simple

demonstration, choose any two fields

in your database for the result, and fil-

ter one of them by the text field

named searchfield. 

3. Add a table to the page to display the

results. To do this, open the Common

tab of the Insert bar and click the Table

icon. Give your table one row and two

columns. Put your cursor in the second

cell of the table.

4. Open the Server Behaviors panel and

find your new server behavior –

Highlight Search String (see Image VII).

Choose the recordset and database

field that you are searching. Fill in the

name of the text field. Click OK. Your

new server behavior should be dis-

played in the server behaviors panel.

5. Finally, add a Repeat Region server

behavior to the table row. The easiest

way to do this is to select the <tr> tag

in the tag selector at the bottom of the

document in Code view, then click the

Repeat Region button on the

Application tab of the Insert bar.

At this stage you should have a com-

plete working search/results page with

custom text highlighting. If you open the

page in Code view, you can see the code

that has been inserted by each of the

server behaviors, including the custom

server behavior you just built. 

Another great thing about server

behaviors is that after you have inserted

them into the page, you can call up your

interface at any time in the Server

Behaviors panel and edit your parame-

ters. As you build more complex code

snippets and convert them to server

behaviors, you’ll soon find this method

easier than modifying the code by hand.

Packaging Your
Server Behaviors

Server behaviors can be packaged as

extensions, giving you an easy way to

install your server behaviors onto anoth-

er computer, or to share among your fel-

low programmers. Unfortunately,

Macromedia did not provide an automat-

ed method of packaging server behaviors

after you’ve built them with the SBB.

Creating an extension package is easy,

however, and a matter of simply writing a

small XML file and using the Extension

Manager to package the files. 

image V

image VI

image VII
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The XML file is stored with an .mxi file

extension, which stands for Macromedia

Extension Information. The file for the

Redirect On Session Value server behavior is

shown in Code III. To package the extension,

simply put the .mxi file into a folder with the

files that were generated by the SBB and

double-click the .mxi file to open the

Extension Manager. The Extension Manager

is like a zip program – it zips all the files into

a package along with path information.

Double-clicking on an extension package

will install the extension into Dreamweaver.

The SBB generated three files – an HTML

file that contains the server behavior interface,

an EDML file that contains information about

the extension, and an .edml file that contains

the code block that will be inserted into the

document. The three files will be located in the

Dreamweaver Configuration folder. In most

modern operating systems, the folder will be

located in the local multi-user folder. For exam-

ple, on Windows XP, the folder is located here

by default: C:\Documents and Settings\[your

username]\Application Data\Macromedia\

Dreamweaver MX 2004\Configuration\

ServerBehaviors\ASP_VBS.

Conclusion
If you followed the exercises, you have suc-

cessfully become a Dreamweaver extension

writer, but more important, you’ve added a

new tool to your arsenal that should signifi-

cantl speed up your workflow. Server behav-

iors are powerful because they insert large

blocks of interrelated code into your docu-

ment, with user-defined parameters present-

ed in an easy-to-use interface. The Server

Behavior Builder is a tool that can increase your

workflow by speeding up repetitive tasks and

making code modifications quickly and accu-

rately using a visual interface. 

Tom Muck is the coauthor of nine

Macromedia-related books, including

O'Reilly’s Flash Remoting: The Definitive

Guide, and Osborne’s Dreamweaver MX

2004: The Complete Reference. He is an

extensibility expert focused on the inte-

gration of Macromedia products with

ColdFusion, ASP, PHP, and other lan-

guages, applications, and technologies.

Tom is also a founding member of

Community MX (www.community

mx.com), a site that focuses on the MX

product line. Tom's Dreamweaver exten-

sions can be found at www.dwteam.com/

extensions/. tom@tom-muck.com
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ASP/VBScript

<%

If Session("SessionVarName") = "ValueToMatch" Then 

Response.Redirect("PageToRedirect") 

End If

%>

ASP/JavaScript

<%

if(Session("SessionVarName") == "ValueToMatch") {

Response.Redirect("PageToRedirect");

}

%>

ASP.NET VB

<%

If Session("SessionVarName") = "ValueToMatch" Then 

Response.Redirect("PageToRedirect") 

End If

%>

ASP.NET C#

<%

if(Session["SessionVarName"] == "ValueToMatch") {

Response.Redirect("PageToRedirect");

}

%>

JSP

<%

if(session.getAttribute("SessionVarName") == "ValueToMatch"){

response.sendRedirect("PageToRedirect");

}

%>

ColdFusion

<cfif IsDefined("Session.SessionVarName") AND 

Session.SessionVarName EQ "ValueToMatch">

<cflocation url="PageToRedirect">

</cfif>

PHP MySQL

<?php

if(isset($_SESSION["SessionVarName"]) &&  

$_SESSION["SessionVarName"] == "ValueToMatch") { 

header("Location: PageToRedirect"); 

}

?>

ASP/VBScript

Block 1

<%

Function highlightSearchWord(theField, theSearchWord)

Dim before, after, myRegExp

before = "<strong>"

after = "</strong>"

Set myRegExp = New RegExp

With myRegExp

.Pattern = "(" & theSearchWord & ")"

.IgnoreCase = True

.Global = True

End With

highlightSearchWord = myRegExp.Replace(theField, before & "$1" & after)

Set RegularExpressionObject = nothing

End Function

%>

Block 2 

<%=highlightSearchWord(rs.Fields.Item("Field").Value, 

rs__searchfield)%>

ASP/JavaScript

Block 1

<%

function highlightSearchWord(theField, theSearchWord){

if(theSearchWord == "") return theField;

var before = "<strong>";

var after = "</strong>";

theSearchWord = new RegExp("(" + theSearchWord + ")","ig");

theField = theField.replace(theSearchWord, before + "$1" + after);
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return theField;

}

%>

Block 2 

<%=highlightSearchWord(rs.Fields.Item("Field").Value, 

rs__searchfield)%>

ASP.NET VB

Block 1

<script runat="server" language="VB">

Public Function highlightSearchWord(ByVal theField As

String, 

ByVal theSearchWord As String) As String

If theSearchWord = "" Then 

return theField 

End If 

Dim before as String = "<strong>"

Dim after as String= "</strong>"

theSearchWord = "(" & theSearchWord & ")"

theField = Regex.Replace(theField, theSearchWord, 

before & "$1" & after, RegexOptions.IgnoreCase)

highlightSearchWord = theField

End Function

</script>

Block 2 

<%# highlightSearchWord(rs.FieldValue("Field", Container), 

(IIf((Request.QueryString("searchfield") <> Nothing), 

Request.QueryString("searchfield"), ""))) %>

ASP.NET C#

Block 1

<script runat="server">

public string highlightSearchWord(string theField, string

theSearchWord){

if(theSearchWord == "") return theField;

string before = "<strong>";

string after = "</strong>";

theSearchWord = "(" + theSearchWord + ")";

theField = Regex.Replace(theField, theSearchWord, 

before + "$1" + after, RegexOptions.IgnoreCase);

return theField;

}

</script>

Block 2 

<%# highlightSearchWord(rs.FieldValue("Field", Container), 

(((Request.QueryString["searchfield"] != null) && 

(Request.QueryString["searchfield"].Length > 0)) ? 

Request.QueryString["searchfield"] : ""))%>

JSP

Block 1

<%!

public String highlightSearchWord(String theField, String

theSearchWord){

if(theSearchWord == "") return theField;

java.util.regex.Pattern pat = 

java.util.regex.Pattern.compile(theSearchWord =

"(?im)(" + theSearchWord + ")");

java.util.regex.Matcher matcher = pat.matcher(theField);

String before = "<strong>";

String after = "</strong>";

theField = matcher.replaceAll(before + "$1" + after);

return theField;

};

%>

Block 2 

<%= highlightSearchWord(rs.getString("field"), rs__search-

field)%>

ColdFusion

Block 1

<cffunction name="highlightSearchWord">

<cfargument name="theField" type="string" default="">

<cfargument name="theSearchWord" type="string"

default="">

<cfif theField EQ "">

<cfreturn theField>

</cfif>

<cfset before = "<strong>">

<cfset after = "</strong>">

<cfset theSearchWord = "(#theSearchWord#)">

<cfset theField = REReplaceNoCase(theField,

theSearchWord, 

"#before#\1#after#","all")>

<cfreturn theField>

</cffunction>

Block 2 

#highlightSearchWord(rs.Field, URL.searchfield)#

PHP MySQL

Block 1

<?php

function highlightSearchWord($theField, $theSearchWord){

if($theSearchWord == "") return $theField;

$before = "<strong>";

$after = "</strong>";

$theSearchWord = "(" + $theSearchWord + ")";

$theField = preg_replace($theSearchWord, $before + "$1"

+ $after, $theField);

return $theField;

}

?>

Block 2 

<?php echo highlightSearchWord($row_rs['Field'], 

$searchfield_rs); ?>

<!--  Redirect On Session Value Copyright 2004 by Thomas

Muck -->

<macromedia-extension

name="Redirect on Session Value

version="1.0.0"

type="ServerBehavior"

requires-restart="true">

<products>

<product name="Dreamweaver" version="6" />

</products>

<author name="Thomas Muck"/>

<description>

<![CDATA[

Redirect a user to another page depending on the value

of a session variable.

]]>

</description>

<ui-access>

<![CDATA[

Access this extension by choosing:<br>

Server Behaviors >> Redirect On Session Value

]]>

</ui-access>

<!-- Describe the files that comprise the extension -->

<files>

<file name="Redirect On Session Value.htm" 

destination="$dreamweaver/Configuration/ServerBehaviors/ASP_

Vbs/"> </file>

<file name="Redirect On Session Value.edml" 

destination="$dreamweaver/Configuration/ServerBehaviors/ASP_

Vbs/"> </file>

<file name="RedirectOnSession_block1.edml" 

destination="$dreamweaver/Configuration/ServerBehaviors/ASP_

Vbs/"> </file>

</files>

</macromedia-extension>
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riginally, I was going to use this

article to present a tutorial on

using PHAkt in conjunction

with PostgreSQL to create dynamic Web

sites. However, as I’ve just returned from

MAX 2003 (a nice show, really), my vision

changed a bit. I was repeatedly told,

“Dreamweaver users don’t work with

server behaviors – they prefer to code

manually.”

I decided to shift the focus of this arti-

cle to include a clearer view of server

behaviors as well as the PHAkt product

overview.

Introduction
Dreamweaver Ultradev 4 was a great

tool for building dynamic Web sites, but

did not include support for Apache and

PHP, a popular duo.

That’s how PHAkt – the PHP Server

Model for Dreamweaver – was born. It

was the most complex effort of its kind,

and it was released as an open source

product (free for download) to a huge

market success.

PHAkt History
Let me give you a hint: PHAkt comes

from PHP and InterAKT. The naming conven-

tion has remained since then, even if many

people reach us by searching “phpakt”.

PHAkt was very popular in the

Ultradev 4 era – people downloaded it

more than 200.000 times, and we

received raves across the board from the

Dreamweaver community. But starting

with the MX version, Dreamweaver

began supporting PHP in the

PHP_MySQL server model instead.

“Why would one still need PHAkt?”

you might wonder. The answer is simple:

PHP_MySQL (as its name implies) can

connect only to the MySQL database

server. While a large number of Web

developers will live with this, some will

opt not to use Dreamweaver for PHP

development because of its inability to

use other databases. Despite its extreme

speed, MySQL is still a “toy” database,

with no support for triggers, stored pro-

cedures, or referential integrity.

Even if you use MySQL, PHAkt can still

help you create powerful applications.

With a PHAkt site, you will be able to

switch to another database later without

regenerating all your pages – something

impossible with PHP_MySQL.

Web Development with
Dreamweaver

Most of today’s Web sites are dynamic

– the content is stored in the database

and rendered on the front end in the visi-

tor browser.

Multiple scripting languages may be

used to create dynamic Web sites;

you might be familiar with

some of them: ASP

(Microsoft Active

Server Pages), CFM

(Macromedia

ColdFusion), and

JSP (JavaServer

Pages). One of the

newcomers in this area

is PHP (PHP: Hypertext

Preprocessor).

To create such Web sites, developers

need to create pages that connect to a

database and then write the actual HTML

output to the client browser (see Image I).

To write script pages, you can use a

text editor or you can choose to use a

professional tool to leverage your work.

Of course, the leader of this latter market

is Dreamweaver MX, the best Web IDE.

Despite popular belief, Dreamweaver

MX is not only a designer tool, but also a

dynamic Web programmer tool. Starting

with the fact that 90% of dynamic Web

development consists of creating lists

with database information and creating

forms to update the database,

Dreamweaver provides a suite of  “server

behaviors” to automate those tasks. This

is one of the most important features in

Dreamweaver MX, and is often not used

to its full potential (read “at all”).

Server behaviors are reusable code

blocks you can use in your Web sites.

Aside from the code, they come with a

useful GUI that allows you to set various

parameters to the code block.

Let’s look at one of the most used

server behaviors (SBs), the recordset. Its

role is to connect to a database, perform

a SQL query, and return a recordset (a

data structure that will store all the rows

and fields returned from the database).

As you can see in Image II, we can set

the name and the database connection

to be used. Notice that most of the SB

interface parameters are bounded prop-

erties, meaning that they are dynamically

retrieved from the database server with-

out the developer having to memorize or

type them.

After you select a database (the data-

base dropdown is loaded with the avail-

able database connections), the table

menu is updated with all the tables in the

current database, and so on.

Applying this SB on the page will out-

creation 

PHAkt 

The InterAKT Dreamweaver MX PHP server model
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put the following code:

<?php

//Connection statement

require_once('Connections/phakt.php');

// begin Recordset

$query_Recordset1 = "SELECT * FROM

name_nam";

$Recordset1 = $phakt-

>SelectLimit($query_Recordset1) or

die($phakt->ErrorMsg());

$totalRows_Recordset1 = $Recordset1-

>RecordCount();

// end Recordset?>

<snip>

<?php

$Recordset1->Close();

?>

What makes SBs useful is that they

not only generate the code for you, but

they also recognize it on the page and

allow you to update one code block by

loading the configuration interface with

all the parameters correctly set. This

allows you to change them and reapply

the SB. If we go behind the scenes, there

is a very complex regular expression

engine that stands behind this mecha-

nism, and there are also some limitations

in recognizing the already-applied code

blocks, but you can easily adapt to them.

Even if some programmers choose

not to use SBs (“they restrict my options,”

“I don’t like the generated code,” etc.),

you should understand that used wisely,

they can really improve how you create

Web sites.

Picture two situations where you

want to create a dynamic Web site:

1. You are a programming guru. You

know how to code, you understand

algorithms, SQL, and LEFT JOINs. What

you do when creating Web sites (and

this means that you list and update

information from the database) is a lot

of redundant pointing to tables and

fields – a very boring task. I don’t think

anyone in the world enjoys it.

2. Conversely, you are a Web designer,

skilled in HTML and CSS, who wants to

make a section of your site dynamic.

You don’t know any scripting lan-

guage, SQL, or other complicated pro-

grammer notions.

How would SBs help both the pro-

grammer and the designer? By writing

the code for them. With SBs, the guru

would be able to have the boring sec-

tions of code automatically generated,

saving time for the really interesting stuff,

and the designer would have correct

script code generated, saving time to

focus on the aesthetics of the site.

Enough about SBs. I encourage you to

look closely at what they can do for you,

as you will be amazed. If you want to find

more, Dreamweaver has tons of docu-

mentation on them and you will find

everything you want in there.

Configuring Your Site 
for PHAkt

To use PHAkt, you have to install the

MXP extension using the Extension

Manager. Just go to our PHAkt site and

download the product; you will find the

phakt-2.6.x.mxp in the PHAkt2 folder.

Clicking it should do the install.

You will need access to a computer

with Apache, PHP, and a database

installed (the database will probably be

MySQL, but any database will do).

You will find a lot of information



22 • MXDJ.COM 3 • 2004

about installing PHP and preparing a worksta-

tion for serving dynamic pages at

www.dreamweavermxsupport.com.

If you want to test PHAkt at work with

another database server, you can get

PostgreSQL and install it. PostgreSQL is one of

the most advanced open source database

servers available, and can compete seriously

with any major player in the industry.

Multiple ports for Windows are available;

we’ve found UltraSQL to be the easiest to

install (http://techdocs.postgresql.org/

guides/Windows). 

Once your Apache/PHP server is set up,

configure Dreamweaver to edit PHP files using

PHAkt. The first step in starting to use PHAkt is

to set up the Dreamweaver site (I assume you

are already familiar with this, so I won’t elabo-

rate)

As shown in Image III, instead of

PHP_MySQL, you have to select PHP_ADODB

for the Testing Server of your configured site.

PHP_ADODB is the server-model name for

PHAkt: a confusing naming convention we set

up a long time ago, but we have to live with it

to keep the backwards compatibility.

When you create new .php files in this type

of Dreamweaver site, they will be “stamped”

with a small PHP comment in their upper sec-

tion:

<?php //PHP ADODB document - made with

PHAkt 2.6.2?>

This is our way of recognizing a page as a

PHAkt page, so you should leave this com-

ment as is. It will not affect your site perfor-

mance, nor will it be included in your site

HTML output.

Improved Database Connection
Let me say this one more time: the most

powerful PHAkt feature is its capability to

transparently connect to multiple databases

from your dynamic Web site. To allow this, we

rely on a PHP objects library – ADOdb. Please

don’t mistake this for the Microsoft ADODB, as

they are completely different and share only

the API function names.

Our ADOdb (actually it’s not ours, it’s an

open source library written by John Lim –

http://php.weblogs.com – but we have

improved it a little bit) simply consists of some

PHP files that will dynamically choose the cor-

rect native database connection library from

PHP and use it. When installing a PHAkt site,

you will not have to install anything on your

PHP server; just copy the site’s files and
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ADOdb will be automatically copied, too.

Let’s illustrate the difference between

ADOdb and pure PHP code by compar-

ing the native PHP_MySQL code with

PHAkt code for a simple SQL query.

The PHP_MySQL code looks like:

mysql_select_db($database_mysql_demo,

$mysql_demo);

$query_Recordset1 = "SELECT * FROM

name_nam";

$Recordset1 =

mysql_query($query_Recordset1,

$mysql_demo) or die(mysql_error());

You can see the mysql_* API calls,

and it’s pretty clear that this code is data-

base specific.

The PHAkt code looks much cleaner,

as the SelectLimit() method called is not

database specific:

$query_Recordset1 = "SELECT * FROM

name_nam";

$Recordset1 = $p-

>SelectLimit($query_Recordset1) or

die($p->ErrorMsg());

$totalRows_Recordset1 = $Recordset1-

>RecordCount();

Of course, ADOdb will call the

mysql_query function, but it uses encap-

sulation to hide this implementation

detail for you.

Creating the Database
Connection

In order to benefit from PHAkt’s capa-

bilities in a site, you must create a con-

nection from the Databases Panel.

When you click on the + sign, Image

IV appears. As you can see, the configura-

tion screen is much more complex than

the regular PHP_MySQL database config-

uration interface. This initial complexity is

in fact the window to many useful and

available features.

Apart from selecting the database

type, you can define a format for the

DATE fields in the database and a loca-

tion for the application messages to be

used later in the application. You can also

decide whether or not the database con-

nection is persistent (persistent connec-

tions use a pool of connections to the

database layer to avoid the reconnection

time penalty, and thus are slightly faster

but more resource intensive).

Dreamweaver Extension
of the Month

by dave mcfarland

ike the air we breathe, links are such an

omnipresent part of Web development

that we often don’t give them much

thought. This month, I’ll present three free

extensions that are simple but useful tools for

expanding Dreamweaver’s link-creating abili-

ties.

Tom Muck’s Quick Link extension has been

around for years, but is still one of my favorite

extensions. It’s simple, efficient, and free; it also

greatly simplifies the process of converting plain

text into a link. Suppose you’ve received a text file

from a client;  you copy and paste the text into

Dreamweaver and realize that the document is rid-

dled with URLs – www.sys-con.com,

www.yahoo.com, and so on. Unfortunately, they’re

simply plain text and you’ve got to change them

into real links. The most basic method, selecting

the URL, copying it, and pasting it into the Property

Inspector’s Link box – is a pain; and if the protocol

– http:// -- is missing, there’s the extra typo-prone

step of adding that as well.

Quick Link makes the process fast and easy.

Just select the text and

choose Quick Link from the

Commands menu. The text is

wrapped in an anchor tag,

with the correct href attribute

attached. If you left out the

http://, don’t worry; the

extension is smart enough to

figure that out and add it for

you. It also works with e-mail

addresses – select an address,

run the command, and the text is wrapped in a link

complete with mailto: added to the address. You

can find this helpful tool at www.dwteam.com/arti

cles/quicklink/index.asp.

Speaking of e-mail addresses – are the address-

es listed on your site safe from spammers? Many

spammers use spiders to crawl Web sites and collect

e-mail addresses for use in their network-clogging

e-mail campaigns. Web masters go to great lengths

to hide their e-mail addresses from such tools – I’ve

even seen e-mail links replaced with graphics con-

taining e-mail addresses. Fortunately, a handy

extension has come

to the aid of Web

developers who are

sick of letting robots

pillage their pages

for e-mail addresses. 

Hide Email, from

Linecraft, is a good

solution. This free

extension (available

at www.line

craft.com/down-

loads.htm) breaks

up and scrambles e-

mail addresses so

robots won’t detect

them. When a user

clicks the e-mail link,

a JavaScript pro-

gram recombines

the e-mail address into a functioning mailto link. 

Dreamweaver’s Open Browser Window behavior is

a tried-and-true classic; great for popping open win-

dows with announcements, Flash

movies, and (unfortunately) ads.

But if you’ve ever wanted a bit

more control over the pop-up

window – for example, placing it

at a precise location on the screen

– you’ve had to add the JavaScript

code yourself. Until now. 

FlevOOware’s Popup Link

extension offers all the options

available in the Open Browser

Window behavior – width, height, chrome controls

– plus the ability to position the window in the left,

center, right, top, or bottom of the screen. In addi-

tion, you can offset the window a set number of pix-

els from the screen’s left, right, top, or bottom

edges. You can find it at www.flevoo

ware.nl/dreamweaver/extdetails.asp?extID=8.

Dave McFarland is the Dreamweaver editor of MX

Developer’s Journal and author of Dreamweaver

MX 2004: The Missing Manual.

davemcfarland@sys-con.com

Links for Simplicity

l

Do you have a favorite extension? Is there an extension you just can’t live without? We’re always on the

lookout for awesome extensions, so drop me a line at davemcfarland@sys-con.com.

Quick Link
Extension Developer: 

Tom Muck

Developer Web Site:

www.dwteam.com/articles

/quicklink/index.asp

Hide Email
Extension Developer:

Linecraft

Developer Web Site:

www.linecraft.com/

downloads.htm

Popup Link
Extension Developer:

FlevOOware

Developer Web Site:

www.flevooware.nl/dream

weaver/extdetails.asp?

extID=8

Price: Free



Supported Databases
PHAkt supports a large list of data-

bases. Unfortunately, we weren’t able to

test PHAkt effectively on all databases,

but the open source community around

the ADOdb project did, so you should

have a very healthy starting point.

We have used PHAkt mostly with

MySQL, PostgreSQL, MsSQL, and Access.

We’ve heard various success stories from

our clients who use Oracle, Informix, and

Firebird (see Image V).

Once you create the connection, you

can start using PHAkt to create Web sites.

As we have followed the Macromedia

GUI’s “unwritten” design rules (believe

me, they are *very* strict when it comes

to uploading on the Exchange), our inter-

faces look very similar to the PHP_MySQL

ones for all of the server behaviors pro-

vided.

Other Improvements
I’ll continue the discussion of PHAkt

by describing some of the other

improvements we’ve made to help pro-

grammers create PHP dynamic Web sites

visually.

Date Locales
InterAKT is located in Europe. Because

we also do contract work, we have clients

around the globe – France, Germany,

Australia, the U.S., to name a few – and in

creating Web applications for them we’ve

had real problems supporting multiple

date formats.

French clients want to edit dates like

“m-d-Y”, Americans want “Y-m-d”, and

Germans want “d.m.Y”. Because they

used MySQL (where you don’t have any

real way of setting the date locales on

the server) on hosted environments

(where we can’t access the server to

change the server locale or anything),

we were forced to think of a solution

that would allow us to read and write

dates in a specific format in the data-

base.

Server Formats from Dreamweaver is

a solution when displaying dates, but it

can’t handle updates at all.

Our solution was to change the

ADOdb wrapper and the PHAkt underly-

ing libraries to allow us to set the date

locale for a specific connection, and then

use this locale transparently when dis-

playing dates and when insert-

ing/updating records in a

table. Thus, it’s very straightfor-

ward for any developer to cre-

ate internationalized applica-

tions (from the date’s point of

view, at least).

The date-locale support was

thoroughly tested with MySQL,

PostgreSQL, and MsSQL, but

we will continue its implemen-

tation based on a client

request.

Supplemental Server
Behaviors

We have also created PHAkt

as a complete server model,

providing some features

Dreamweaver 6.1 didn’t have

(MX 2004 seems to have cor-

rected this issue).

When working with PHAkt,

you will be able to use:

• User authentication server

behaviors

• Master/Detail server behav-

iors

• Go to Detail Page server

behaviors

PHAkt has several other advantages

as well.

• Code reuse: We keep the code that

can be reused in a functions.inc.php

file that is available when needed.

• Apache2 header redirect support: In

Apache 2 on Windows, relative redi-

rects don't work anymore.

• Advanced Recordset: This allows you

to define other data sources and still

reuse the current server behaviors.

This advanced Recordset is probably

one of the most powerful features in

PHAkt, since we overcome a major

Dreamweaver limitation. It normally

allows you to use a specific server behav-

ior for only one data source. If you want

to define a new data source, for a shop-

ping cart, for example, you will have to

reimplement all the features like “Repeat

Region”, “Show If”, etc.

Extending PHAkt
Dreamweaver MX is a platform built

with extensibility in mind, extensibility

that allowed InterAKT to create PHAkt.

Using the same approach, developers

around the world can create new features

that will plug into Dreamweaver to

enable it to support more functionality.

Only a few companies create exten-

sions for PHAkt (they usually focus on

PHP_MySQL), but you will find all you

need in the list below (shopping cart

extensions, query builders, form genera-

tors, horizontal looper and nested repeat

regions, etc.):

• InterAKT MX Kollection:

www.interakt.ro/online.com

• Felixone Extensions:

www.felixone.it/extensions/dwexten-

sionsen.asp

• Advanced Query Wizard:

www.advancedextensions.com/ 

Note: Most of the PHAkt extensions pro-

vided by these companies are commer-

cial.

PHP in the Enterprise
Even if PHP has recently been

designed from scratch, it has rapidly

evolved into a fully featured, easy-to-use

programming language for productive,

dynamic Web site development.

To get some real information on the

PHP market, we conducted extensive
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market research, and the results may be

helpful if you are really serious about

PHP. Our research involved 700 respon-

dents, and we managed to get a clearer

view on the software development mar-

ket for PHP and its relationship to medi-

um and large enterprises. Read the sur-

vey to see our estimate of the number of

PHP developers, the average price of a

PHP Web site, and some golden rules to

promote PHP in an enterprise setting.

Our full market research analysis is locat-

ed at www.interaktonline.com/index_art

_11.html.

Conclusion
Let’s take one last look at a summary

of PHAkt’s features.

Upside

The most important PHAkt feature is

its ability to connect to multiple data-

base types. This allows you to create

advanced PHP sites, but if you use

MySQL, you’ll be able to change the

database after developing the site with-

out having to re-implement it.

Overall, PHAkt is a step further

along in creating PHP sites with

Dreamweaver MX, as it integrates a set

of improvements that ease software

development.

Downside

Unfortunately, there is also a down-

side to PHAkt, and the most important is

that there are only a few extensions avail-

able for PHAkt.

Also, because of the ADOdb usage,

PHAkt is slightly slower than native con-

nections, but if you want to create some-

thing extensible you will find ways to

correct this using various techniques

(PHP accelerators, indexes in the data-

base, ete.).

PHAkt’s Future
We will continue the work on PHAkt

to provide the professional alternative for

PHP Web site development in

Dreamweaver.

We plan to merge PHAkt with the

InterAKT Transaction Engine (tNG), a

much better way of creating forms with

associated events (send mail, upload

image, et.). We want to include PHP 5

support and enlarge the included server

behaviors and commands set.

Next Steps

As all regular server model features are

present in PHAkt, you can rely on standard

Dreamweaver MX Help to get used to the

server behaviors and commands.

You will find server behaviors to cre-

ate lists with records from a Table –

Repeat Region, to apply conditional

regions – Show if Recordset is Empty, and

to create insert, update, and delete forms

for a table.

PHAkt also comes with several tutori-

als and documentation, so you should be

able to get started quickly.

I hope you have a better view of what

Dreamweaver MX, server behaviors, and

PHAkt can do for you. Just go and down-

load our extension and start creating

dynamic Web sites now! 

Resources
• PHAkt can be downloaded from the

InterAKT Web site: www.interakt.onj-

line.com/products/PHAkt

• Various PHAkt discussions: www.inter-

akt.ro/products/bbs/index_0.html 

• ADOdb database abstraction layer:

http://php.weblogs.com/ADOdb/

Alexandru Costin is one of the founders

and chief operating officer at InterAKT

Online. As one of the InterAKT product

architects, he has contributed to

PHAkt’s initial development and now

designs the next generation of InterAKT

products. He co-authored Professional

PHP Web Services and posts regularly

to the Dreamweaver MX–related boards.

acostin@interakt.ro
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The ‘Extensibility Layer’
With any new version of a software

product, a whole new host of features is

introduced – Macromedia Flash MX 2004

is no different. The most significant new

feature in the latest release of Flash is the

“Extensibility Layer.”

The “Extensibility Layer,” as

Macromedia calls it, is a general term that

covers a range of new, exciting features

that make it possible for Flash developers

to create and implement their own new

features directly into the Flash Authoring

Environment. Various third parties are

already commercially distributing their

own Flash Extensions that add new fea-

tures to the IDE. For example, the makers

of SWiSH, the ever-popular text effect

tool, are now selling a Flash extension

called SWiSHpowerFX that allows Flash

designers to select a text field on the

stage and apply various SWiSH text

effects to that text. 

The Extensibility Layer makes it possi-

ble to write macros that will automate

common tasks, write tools that manipu-

late objects on the stage, create panels

that contain graphical user interfaces,

write Timeline effects that animate

objects on the stage and much, much

more…

Introducing JSFL
Taking advantage of these new possi-

bilities requires knowledge of a new

scripting language that lets us talk to the

Flash MX 2004 IDE and tell it what to do.

This new language is commonly called

JSFL.

Those of you who have seen snippets

of JSFL floating around may have noticed

a striking similarity between that and

ActionScript or JavaScript. Well spotted!

The good news is that Macromedia based

JSFL on the Netscape JavaScript API,

which means that ActionScript coders

like me, or anybody who has dabbled in

JavaScript, won’t have to learn a

whole new programming lan-

guage. The syntax is exact-

ly the same, dot syntax,

and we still work

with the same data

types: objects,

arrays, strings,

numbers, and

functions.

As this arti-

cle is written

for Flash

developers, it

assumes

knowledge of

ActionScript.

JSFL is based

around a

Document Object

Model (DOM) that

exposes a hierarchy of

objects that represents the

structure of a Flash document in

the form of a hierarchical tree, very simi-

lar in nature to a family tree. Each object

allows you to dynamically access and

update the structure of a Flash docu-

ment. The key to learning to write your

own Flash extensions is to understand

the Flash DOM, which I cover in great

detail in this article.

Types of Flash Documents
Flash MX 2004 works with two types

of documents; the first is the standard

timeline-based document that users of

previous versions of Flash are familiar

with, and the second is screen-based

documents, which have been introduced

3 • 2004
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into Flash MX 2004. Screen-based docu-

ments use a different metaphor for

organizing your movies, and you will

know them as Form Applications and

Slide Presentations.

The DOM of a screen-based docu-

ment differs slightly from that of a time-

line-based document, and because time-

line-based documents are the most com-

mon document I cover only their DOM in

this article.

Anatomy of a Flash
Document

To begin with, think about each of

the different parts of a Flash document.

Flash documents comprise:

• Timelines

• Layers

• Frames

• Symbols

• Shapes

• Text fields

• Library

Different types of symbols are stored

in the library:

• MovieClips

• Buttons

• Graphics

• Bitmaps

• Sounds

• Videos

• Components

Timeline-based documents have a

library and one or more timelines

(scenes). MovieClips, buttons, compo-

nents, and graphics have their own time-

lines. Timelines contain layers; layers con-

tain frames; and keyframes contain

instances of symbols from the library,

shapes, and text fields.

Note: It’s important to realize that

Flash works with groups of frames (not

individual frames); a group of frames

begins with one keyframe and ends at

the frame before the next keyframe on

that layer, or the last frame in that layer,

whichever is first. Each frame in a group

of frames refers to the first frame in the

group (the originating keyframe).

The Flash DOM represents this hierar-

chy and each separate element of a Flash

document as objects. So there is a unique

object for each layer in a Flash document;

there is also a unique object for every

frame in a Flash document, and so on.

These objects have properties that

describe that particular element; for

example, all layer objects have a “name”

property that contains the name of that

particular layer.

Image I contains a timeline that con-

tains one layer; this layer is named “Layer

Name”. In JSFL, we can access the name

of that particular layer using

theLayerObject.name;

Each type of object may also have

associated methods that manipulate that

particular object in its visual form in the

Flash IDE; for example, all timeline

objects have a method called

“deleteLayer” that removes a particular

layer from that particular timeline.

In JSFL, we can get Flash to delete the

first layer of a timeline using:

theTimelineObject.deleteLayer(0);

Object Relationships
These objects have a parent/child

relationship; each layer object contains

references to its child frames, which are

grouped together in an array. It is there-

fore said that a frame object is a child of a

layer object. The parent of a layer object

is the timeline object, which represents

the timeline in which that particular layer

resides. These relationships are similar in

practice to a nested MovieClip hierarchy

in a Flash movie.

When a JSFL script is executed, an

object is created for each separate ele-

ment in every Flash document that is

presently open in the Flash IDE. Thus your

scripts can refer to any element of any of

the open Flash documents using dot syn-

tax to traverse that particular document’s

DOM.

Image II shows the parent-child rela-

tionship between the different elements

of a Flash document and the hierarchical

tree structure.

Think of each section in Image II as a

separate class or type of object. Child

objects that are the same color as their

parent are simply subclasses of their par-

ent, or extensions of the parent object

type. For example, Shape is a subclass or

extension of the Element object; similarly,

FontItem is a subclass or extension of the

Item object.

In Image II labels point to the inter-

sections between various objects. If an

intersection represents a subclass or

object relationship (the color of the par-

ent and children is the same), then the

label will contain the property you need

to access to determine the type of object

you are working with. 

If, however, the parent-child relation-

ship represents an object type, which can

be accessed as a child of the parent, then

the label will tell you the property you

need to access to reference each child

element. For example, the relationship

between the Library object and the Item

object is not a subclass relationship since

the colors of parent and child are differ-

ent. Thus, the label tells us that we can

access the child items of the Library

object using the library.items property,

which is an array in which is a collection

of Item objects.

Here’s a simple example: let’s say I

have a Flash document that contains one

MovieClip on the stage of the first frame

of the first layer of the first scene. To

access that MovieClip’s object, I would

have to traverse the DOM using dot syn-

tax as follows:

theMovieClipObject=flash.docu-

ments[0].timelines[0].layers[0].frames

[0].elements[0]

In this particular example, we know

that the one and only element on the

stage is a MovieClip, and at times there will

be numerous elements on the stage. As

illustrated in Image II, an element can be of

type Shape, type Text, or type Symbol; and

the properties available to those objects

differ, thus we need to determine what

type of element we are working with. To

do this we use the elementType property:

theElement=flash.documents[0].time-

lines[0].layers[0].frames[0].ele-

ments[0]

elementType=theElement.elementType

The elementType property can have

three possible values: “shape”, “text”, or

“symbol.” If the element is a MovieClip,

graphic, or button, then the value of the

elementType property will be “symbol”,

and thus we now know that we are work-

ing with a Symbol object. This means that

our Element object will contain all the

properties that that Symbol object con-



tains.

Top of the Tree
A parent-child relationship has to

stop somewhere; therefore, there is

always one root object, the “top of the

tree” or the “daddy of daddies,” so to

speak. In the Flash DOM, the root object

is the object that represents the Flash

application. 

Note: The Flash application has its

own object, and each Flash document is

a child of that object. This object is

always accessible in JSFL scripts and goes

by the name “flash”. It can also be

accessed using the shorter name “fl”.

The root object contains the child

objects that represent each Flash docu-

ment presently open in the Flash IDE;

these document objects are grouped

together in a property called “docu-

ments” that is an array:

flash.documents

To access the object of the first docu-

ment open in the Flash IDE with a JSFL

script, I would use:

firstDocumentObject=flash.docu-

ments[0];

The “flash” object also has various

methods that allow you to manipulate

the actual Flash application and mimic

the actual functionality the Flash applica-

tion provides; for example, in the Flash

IDE it’s possible to close the Flash applica-

tion by simply opening the File menu

and then selecting the Quit option. We

can do the same thing with JSFL in our

scripts by calling:

flash.quit();

In the Flash IDE, it is also possible to

close the currently focused document

simply by opening the File menu and

selecting the Close option. Again, we can

do the same thing with JSFL in our scripts

by calling:

flash.closeDocument(theDocumentObject)

;

For a full list of the various objects

and their associated methods and prop-

erties, check out Macromedia’s official

JSAPI Documentation at http://live-

docs.macromedia.com/flash/mx2004/jsa

pi/index.htm.

Predefined Classes
As with ActionScript, JSFL has a set of

predefined classes containing methods

and properties:

• Array

• Boolean

• Date

• Function

• Math

• Number

• Object

• RegExp

• String

ActionScript coders will notice one

more class, the RegExp class. No, that isn’t

a mistake; you can use Regular Express-

ions in JSFL!

In JSFL, as in ActionScript, every string

is an instance of the String class, every

array is an instance of the Array class,

every number is an instance of the

Number class, and so on. This means that

strings, numbers, arrays, Booleans,

objects, etc., are treated in exactly the

same way as they are in ActionScript.

All Strings have the usual String

methods: “substr”, “charAt”, “indexOf”, etc.

All Arrays have the usual Array methods:

“splice”, “pop”, “push”, etc.

For example, we can do:

myStr="A,B,C,D";

bits=myStr.split(","); //use a string

method

Or:

myStr="abcd";

myStrLen=myStr.length; //get a string

property

In both JSFL and ActionScript the

above code snippets produce the same

result. For a complete list of classes, avail-

able methods, and properties refer to the

Netscape JavaScript API Web site

(http://devedge.netscape.com/central/jav

ascript/).

Top-Level Properties and
Methods

JSFL also contains some top-level

functions; these are functions that are

not related to any particular object or

class and thus can be used anywhere in

your scripts.

• encodeURI

• decodeURI

• eval

• Infinity

• isNaN

• Number

• parseFloat

• parseInt

• alert

For information on the functionality

of these functions, see the Netscape

JavaScript API Web site.

Writing a JSFL Script
You create a JSFL script like you would

an external ActionScript file. Using your

favorite script editor, write your JSFL code,

then save the file with a .jsfl extension.

You can call the file whatever you like as

long as it has the correct file extension. 

The Flash MX 2004 Authoring Tool

has a built-in JSFL Script Editor, which is

the same as the ActionScript Editor. You
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can use it to create a new JSFL script by

opening the File menu and then select-

ing New > Flash Javascript File.

You can also open JSFL scripts for

editing in Flash MX 2004. Naturally, your

JSFL script will automatically open for

editing in the JSFL Script Editor. To edit a

JSFL script in Flash MX 2004, open the

File menu and then select Open. From

there you want to navigate through your

local machine to find the correct JSFL

script to edit.

As with the ActionScript Editor, the

JSFL Script Editor also contains a list of

every available object and its available

methods and properties along the left-

hand side. This comes in very handy as

there are a lot of them to remember. Roll

over a particular method or property on

the left-hand side and you will get a tool

tip that briefly describes what that partic-

ular method or property does (see Image

III). The JSFL script editor also has syntax

highlighting and code hinting.

Executing a JSFL Script 
To execute a JSFL script, the Flash MX

2004 IDE must be open. The simplest

form of a Flash extension, the command

has its own special place in the Flash MX

2004 IDE – the Commands menu. In the

Commands menu is a Run Command

option. When you choose this option, you

can then locate a JSFL script to execute.

The Commands menu displays three

default options, but it also adds a new

option for each JSFL script contained

within a special Commands directory in

the Flash MX 2004 Configuration folder.

The location of the special Commands

directory on your local machine differs

with different operating systems.

If you place your JSFL scripts in this

directory, you can execute them directly

from the Commands menu by selecting the

appropriate Commands name from the list

of options. The name that is displayed in

the Commands menu is simply the name of

your JSFL Script file (see Image IV).

As shown in Image IV, I have four JSFL

Scripts, located in my Configuration

/Commands directory, with the file

names:

1. Batch Run.jsfl

2. Convertor.jsfl

3. Save Copy As.jsfl

4. Test.jsfl

Selecting any of these options in the

Commands menu will execute the JSFL script.

When a JSFL script is executed, all

functions that are called update the state

of a particular element in a Flash docu-

ment immediately, which differs from

ActionScript execution. 

For example, in ActionScript, if we

were to move a MovieClip across the

stage in a for loop, we would see only the

final state of the loop as the stage is not

updated until the ActionScript has been

executed. However, if we were to call the

“deleteLayer” function of a Timeline

object in JSFL inside a for loop, the layer

is immediately deleted and the Authoring

Environment will refresh to display the

new state of the timeline, before the

code after the for loop is executed.

The History Panel
The Flash MX 2004 IDE contains a

History panel: Window>Other

Panel>History. The History panel tracks

every interaction you make with the Flash

MX 2004 IDE. Each interaction is listed in

the History panel as a separate action in

the order in which the actions took place.

At any time, you can select one or more of

the actions you previously performed and

replay them. For example, if you draw a

new rectangle on the stage, a new action

is listed in the History panel (see Image V).

If you then deleted that rectangle

from the stage, you could draw that rec-

tangle in exactly the same place, at exact-

ly the same size, by simply selecting the

Rectangle action from the History panel

and then clicking the Replay button, or

by right-clicking the action and selecting

the Replay Steps option from the drop-

down list that appears (see Image VI).

When you undo a change you have

made in Flash MX 2004, using File>Undo

(CTRL + Z), that particular action is then

removed from the History panel. The

opposite is true when you then choose to

redo that action because you didn’t

mean to undo it in the first place:

File>Redo (CTRL + Y). The action is then

added to the bottom of the actions list in

the History panel.
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  I often receive 

photographs from 

readers asking me 

what went wrong. The 

picture files are too 

large or of poor quality.

by charles e. brown

PERFECT
PICTURE
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This month, we’re going to look at

some ways of improving your quality

both within, and outside of, Fireworks

MX. We’ll see how to get the picture into

Fireworks MX and, once in, how to make

it look better.

Getting the Picture into
Fireworks MX

Getting the picture into Fireworks MX

properly is the first step of the process.

This may seem pretty obvious at first.

However, there are a lot of little tricks

that even seasoned professionals fre-

quently overlook.

The first thing you need to deter-

mine is whether the source of the

photograph is going to be a scanner

or digital camera. The price of both

these items has dropped considerably

over the past couple of years. A good

quality scanner is around $100 (you

can even get them bundled with a

printer and a copying machine in

one), and a digital camera costs

around $300.

A word about digital cameras is in

order. The quality of a camera is mea-

sured in megapixels. You can get a 2

megapixel camera for around $300, or

spend upwards of $1,000 for a 4

megapixel camera. In most Web situa-

tions, 2 megapixels is more than suffi-

cient. I personally own a 2 megapixel

and, at the Web setting, it provides very

high quality.

Most cameras and scanners have a

Web setting that will determine the size

and then give you the smallest dpi (dots

per inch) without significant loss of qual-

ity. For instance, a Web output might be

around 72 dpi; but a high-quality print-

ing job might be around 300 dpi.

Recently, a friend called me about all

of his scanned pictures being blurry in

spots. After some examination, we deter-

mined that the problem was fingerprints

all over the glass of the scanner. If you

do a lot of scanning, use a good lens

cleaner to keep your glass free of

smudges, dust, and fingerprints. 

Assuming your scanner is installed

properly, with all the proper drivers, you

should make sure that the source that

needs scanning is placed properly in the

scanner. Once that is done, from within

Fireworks MX, select File > Scan > TWAIN

Acquire. (Note: if you are working with

more than one scanner, you may first

need to select File > Scan > TWAIN

Select.) The image should load right into

Fireworks MX.

Most digital cameras use the USB

port and are recognized as another

hard drive letter. All you usually need to

do is use Windows Explorer (or the

operating system of your choice) to

drag and drop the photographs from

the camera to the folder you need to

put them in on your local hard drive.

From there on, you can simply open

them up in Fireworks.

Once the Image Is In 
Once the image is inside Fireworks

MX, you can do all sorts of things to

improve its quality. The photograph

shown in Image I is a bit scratchy and

poorly shaded. 

By simply selecting Filters > Adjust

Color > Auto Levels, you can clean up a

lot of the problems so that the Image I

photograph now looks like Image II.

Understanding the
Histogram

With a picture open, you can select

Filters > Adjust Colors > Levels. This is

called a histogram and an example of

one is shown in Image III.

The histogram shows three charac-

teristics: Shadow, Midtone, and Highlight

colors. There are three sliders under-

neath the histogram, one for each of the

characteristics.

If a picture has too much shadow,

details will be hidden; too much high-

light will give the picture a washed out

look; and too many midtones will make

the picture look dull.

There are three ways in which you

can change the characteristics: you can

use the sliders (if you are a beginner,

this might be the easiest technique);

you can use one of the three correspon-

ding eyedroppers; or you can type the

amount in one of the three Input Level

fields.

You will notice that this particular

photograph looks very unbalanced. We

can use the histogram to do some

repairs. As an example, I can select the

first eyedropper (for shadow) and click it

in the hair region of the photograph.

The results will be something like Image

IV.
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This will help sharpen your photo-

graph considerably. However, you may

notice that there now seem to be too

many midtones, which are creating a

blotchy effect. You can use the midtone

slider in the histogram  to cut that down

a bit.

Add a Drop of Color
You can do some interesting high-

lighting to a photograph by using the

Brush tool and a low opacity percent-

age. For instance, in Image V I used the

Brush tool and set the color to soft

gray. I used the Soft Rounded head with a

diameter of 2 and I set the opacity to

about 20%. I touched up the hair and a

little of the shirt area as shown in Image

V.

This will take a little experimentation,

and a good eye, on your part. However,

you can see that there are many possi-

bilities. I strongly suggest that you look

at my discussion of blending modes in

the February issue of this journal (MXDJ,

Vol. 2, issue 2). Many of the ideas I show

there can be easily applied to this discus-

sion.

If you open a color photograph you

will see an even more pronounced his-

togram (see Image VI).

The photograph that this histogram is

referencing has a lot of peaks around the

the midtone area. 

Another possibility for adjusting color

is to change the curve. You can do that

using Filters > Adjust Color > Curves (see

Image VII).

The Curves feature is similar to the

Levels feature but it provides more pre-

cise control. Levels uses highlights, shad-

ows, and midtones to correct the tonal

range, while you can use Curves to cor-

rect for a color cast caused by improper

lighting.

We simply click on the curve and drag

it to find that precise balance. 

The final idea you might want to try is

to take an image, such as the black and

white portrait used in Images I and II, and

create a background for the canvas.

Experiment with color, opacity, and blend

modes.

Next month, we’ll discuss filters and

how to create some cool effects with

them. 

Charles E. Brown is the author of

Fireworks MX: From Zero to Hero and

Beginning Dreamweaver MX. He also

contributed to The Macromedia Studio

MX Bible. charles@charlesbrown.net
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W henever I tried to 

win an argument 

with my mother, she’d 

usually end up saying the 

final words: “Like it or get 

used to it.” That’s the way 

it is with the multitude of 

programs graphic artists 

use today. Incorporating 

multiple programs into a 

single, seamless suite is 

an extremely difficult 

concept. When programs 

are developed by different 

companies, and those 

companies are merged 

into conglomerates, 

technologies collide and 

so do our brain cells as we 

try to cope with program 

similarities and 

differences.
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Macromedia Studio MX is certainly no

different. Having used FreeHand since

the late ‘80s, it’s only natural for me to

think that newer Macromedia programs

like Flash and Fireworks would utilize the

same tools and tool functions that

FreeHand introduced and developed. But

since other teams with their own priori-

ties developed the newer programs

(sometimes from other companies),

we’ve ended up with quite a few incon-

sistencies. Due to user expectations for

each program, Macromedia reworked

tools to create as much uniformity as

possible. In most instances this works,

but at other times it falls considerably

short of uniform.

In the absence of one program that

does it all, we users must adapt. Flash does

many things that could be done in

FreeHand, but Flash is an animation pro-

gram. If you want real drawing power,

you’ll have to turn to FreeHand. FreeHand

was built from the ground up as a drawing

program, and its toolset is second to none

(one if you’re a die-hard Adobe Illustrator

user). The accuracy and repeatability inher-

ent in FreeHand surpass anything Flash can

do, but there are several differences that

you’ll have to “like or get used to.”

PROBLEM: Stroke ends

become rounded when

imported or pasted into

Flash.

SOLUTION: Get used to

it. There is a simple work-

around however if you know

that you won’t be modifying

the shape of the path in Flash. Use the Trace tool in FreeHand to trace a path

or dashed line. Give the tracing a stroke of none and a solid fill to retain

sharp-cornered dashes. You can copy and paste the traced path into Flash or

export it as a Macromedia Flash SWF file. Another solution is to use the

Expand Stroke Xtra, opting for square end caps; give the path a stroke of

none and whatever fill color you want. 

PROBLEM: The Pointer tool changes curves in

Flash, but only moves paths in FreeHand.

SOLUTION: You should learn to like this. Use the

Pointer tool or Subselect tool to adjust point control

handles. Change the type of point from Corner to

Curve to Connector in the Object panel. To adjust

path sections with control handles while using the

Pen or Bezigon tool, hold down the Command/

Control key to temporarily switch to the Pointer tool;

add the Option/Alt key to reach the Subselect tool.

You can also use the Pointer tool to push or pull a

line segment by holding down the Option key as you

drag the path segment. If you see a plus sign (+), you

are duplicating the path – be careful.

PROBLEM: Curves created in

FreeHand are modified when imported

or pasted into Flash. 

SOLUTION: Due to the way each

program creates paths (see the Bézier

Curve sidebar), you will have to tweak

the path in FreeHand and check the

import in Flash until it meets your

expectations. 
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image IV

PROBLEM: The Pointer tool is used to

pull or push path sections in Flash, but it

isn’t in FreeHand.

SOLUTION: Get used to it. If you

want to smoosh, squeeze, or scooch

sections of a path in FreeHand, use

the Freeform tool. This tool will push,

pull, or reshape a path, changing,

adding, or deleting points as you

work. 

In Push/Pull mode you can push or

pull the path. Double-click the tool in

the toolbox (it may be hidden behind

the Roughen or Bend tools – click and

hold on either of them to be able to

select it from the pop-up menu). As

shown in Image I, with the Push/Pull

option you can set the size of the tool in

pixels from 1 to 1000. The Precision set-

ting determines how many points may

be added to the path – larger numbers

will add more points and therefore high-

er precision. The Pull setting allows you

to pick Between Points or By Length. If

you choose Between Points, the entire

path segment will be modified. A By

Length setting will create a modification

in the length you set in pixels in the

Length window. All of the settings in

this dialog box can be entered manually

or by moving the sliders. Last, if you

have a pressure-sensitive drawing tablet

you can choose to have either or both

size and length determined by the pres-

sure you apply to the pen. You must

click the OK button to close the window

and use the tool. It doesn’t take long to

get the hang of using the tool. If you

click on the path and start to drag (pull),

you’ll notice the little “s” next to the cur-

sor as the path changes according to

your settings and the amount you drag.

To push the path, click next to the

path. A circle is added to the cursor

as you push a curve into the path. 

In Reshape mode the settings are

about the same, with the addition of

a Strength value. This is indicated as

a percentage and indicates how

strong the distortion will be. The cur-

sor changes to something you’ve

never seen in FreeHand – three con-

centric circles (see Image II). The cen-

ter circle is where the cursor tip is,

the middle circle indicates the strength

of the distortion, and the outer circle

marks where a point or points will be

placed on the path. Additional points

will be placed as required to make the

new curve. 

I have a Wacom Intuos2 on my lap

whenever I’m working in a drawing or

photo manipulation program, and I can’t

recommend it highly enough. It’s impor-

tant to note that if you are using a graph-

ic tablet, the path distortion changes in

direct relation to the settings you’ve

opted for in the dialog box. You can start

out with a wide round shape and, by

releasing pressure on the tablet, reduce

the distortion to a skinny dart. Without a

tablet, pressing the keyboard arrows

reduces or enlarges the size of all three

Freeform tools on the fly (see Images III

and IV).

image III

image II

image I
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PROBLEM: The Pointer tool can be

used to remove sections of a path in

Flash, but selects entire paths in

FreeHand.

SOLUTION: Like it. Compared to

FreeHand, Flash uses a fairly haphazard

method of selecting the sections. With

the tools in FreeHand (see Image V), you

can be extremely precise.

Knife Tool

Double-click the Knife tool to bring up

its dialog box. The settings are pretty

straightforward. The Freehand option lets

you cut through objects as if you were

drawing with the Pencil tool. Hold down

the Option/Alt key to draw a straight line;

use the Shift key to constrain the slice to

45° increments. The Straight option draws

straight lines without the Option/Alt key.

The width can be set from 0 to 72 points

(1 inch). The path will be cut in two places

separated by the distance you put in this

field. When you make the knife cut, the

path stays selected and you see the new

points. Deselect the path by pressing the

Tab key, or Command/Control, clicking the

cursor away from the path. Now you can

select the section that you cut and delete

it or use it in some other way. The last two

options in the Knife dialog box are Close

Cut Paths and Tight Fit. The first adds two

points, one on top of the other in the path,

and allows a closed path with a fill to

remain intact. Deselecting Close Cut Paths

will turn the path into an open path, and

unless you have Show Fill for New Open

Paths set in your FreeHand Preferences,

the fill will disappear. With that option in

play, the fill will show as it did originally.

The Tight Fit option adds precision to the

course your cursor takes while you’re cut-

ting with the knife. To use the Knife tool,

simply drag it across a selected path.

Split Command

The Split command is extremely pow-

erful because it can be accessed in so

many ways. The concept is to select a

point or several points on a single path or

many paths. Then do one of the follow-

ing:

• Choose Modify>Split from the menu

• Use a custom keyboard shortcut 

• Click the Split icon that you’ve placed

in your main toolbar
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No matter which method you use, the

paths will be separated at every selected

point. To reconnect the path sections, use

the same methods with the Join com-

mand.

Eraser Tool

This tool is new in FreeHand MX. It

works similar to the Knife tool, only you get

a lot more bang for your buck. Double-

clicking the Eraser tool icon brings up a

dialog box where you can set minimum

and maximum widths for the eraser tip.

The numbers relate to the units of measure

you have the document set to. Here’s

where the Wacom tablet comes into play

again, because now you can draw free-

hand inside objects. Tip size can also be

changed as you’re working by pressing the

keyboard arrow keys. Image VI shows a lit-

tle of what can be done on a map. A rec-

tangle was given a gradient fill, and anoth-

er rectangle with a solid color was placed

directly above it. The Eraser tool was given

identical Min and Max widths to create a

consistent line width; then, holding down

the Option/Alt key to constrain the tool to

a straight path, lines were drawn into the

rectangle. Draw in freehand (Pencil tool)

style without the modifier keys. If the path

cuts through two sides of the object on

the first cut, the object will become sepa-

rate objects. That means that every section

you want to reapply the Eraser to will have

to be selected. However, punching a small

hole prior to the “real” editing with the

Eraser creates a compound path that will

remain selected as you draw with the tool.

Another bonus of this method of drawing

is that any erasures take on the stroke

attributes of the object it’s erasing. In

Image VI, a custom brush tip was applied

in a spray pattern to add texture to the

strokes. The Eraser tool does not work on

live text.

Image VII goes a little further with

the usefulness of the Eraser tool. The

color NASA image from Mars is overlaid

with a rectangle with a black Lens fill

set to darken by 50%. Using the eraser

tool, the rock, was outlined. Then the

center dark area of the rock isolated by

the erasing was selected with the

Subselect tool and deleted, leaving a

full-color image popping out of a

severely desaturated background –

without Photoshop.

image VII
Bézier Curves in
FreeHand and Flash
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A path drawn in FreeHand and

imported to Flash sometimes loses its

original shape, and a path drawn in Flash

may be different when the file is opened

later. What in the world is going on?

The reason the rules are so flexible is

mainly because FreeHand’s PostScript for-

mat utilizes Cubic Bézier curves, and Flash’s

SWF files are made of Quadratic Bézier

curves – I know, your eyelids just got very

heavy. The short definition of a Bézier curve:

points on a page are connected by a path

and described in computer code as a math-

ematical equation. For a more detailed

description you can read all about Bézier

curves at www.moshplant.com/direct-

or/bezier/. FreeHand’s Bézier curves utilize a

control handle for each end segment of the

curve, whereas Flash’s curves have only one

control handle for the curve.

That means when you draw something

in FreeHand or Flash, both Pen tools use

control handles at each end of a path, and

the initial path is drawn the same way. But

when it comes to editing the curvature of

the path different methods must be

employed. In Flash, after a path is drawn,

use the Pointer tool to modify the path by

clicking and holding on the path, then drag

to change the curve. Flash will add points

and control handles to the path as you

drag, but you won’t see them until you

select the path with the Subselect tool.

Clicking individual points will cause the

control handles for the point to appear. If

you click the Pointer on a path, a section of

the path will be selected. You can move

that section in its entirety, resize it, change

its color or thickness, or delete it if you wish. 

However, in FreeHand it’s a different

story. You usually modify the curvature of

a path by using the Pointer tool or

Subselect tool to adjust connector han-

dles. The path remains contiguous unless

you use one of several methods to break

it. For this discussion, we’ll consider that

you want the path to remain whole. 

Any FreeHand user will tell you that

the easiest way to modify a path is to

adjust the control handles. There are two

schools of thought as to when that

adjustment is done. One school plots

points in a semi-accurate array without

regard to complete curve conformity.

When this artist is done placing all the

points with the Pen or Bezigon tool, he or

she goes back around the path and

adjusts control handles and/or points to

make the path fit the shape accurately.

The other school – which I believe has the

largest enrollment – places a point and

adjusts the control handle immediately.

When the last point is placed, the path is

complete. As you place a point, keep the

mouse button down and drag away from

the previous point. This pulls out a pair of

control handles that happen to extend

equally on either side of the point you

just placed. The control handle you

dragged out actually affects the shape of

the path to the next point you place. With

Show Pen Preview selected (double-click

the Pen or Bezigon tool in the toolbar),

you can see what the path will look like

after the next mouse click. If you don’t

want a curve on the next path section,

click the tool on the last point. The con-

trol handle will disappear and the next

point you place will give you a straight

path from the last point. Dragging as you

place that point will create a new set of

control handles that you can manipulate

to create a curved path. 

FREEHAND CUBIC
BÉZIER CURVES

FLASH QUADRATIC
BÉZIER CURVES
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There’s no getting around the fact

that both Flash and FreeHand have some

drawing tools and tricks that could be uti-

lized in each other’s program. Until that

happens, take the time to experiment with

the FreeHand toolset and save yourself a

lot of frustration. I think you’ll grow to real-

ly like FreeHand’s drawing capabilities.
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PROBLEM: Why doesn’t FreeHand

allow overlapping objects to be

removed as they can in Flash?

SOLUTION: You’ll learn to like it. In

Flash, if you draw objects that overlap all

contiguous shapes are modifiable sepa-

rately. Every new object creates a divid-

ing operation, effectively removing the

overlapped portions. In FreeHand, over-

lapping objects remain intact unless you

use some of the path operation tools.

Refer to Image VIII for examples. The

original art consists of a square, a circle,

and a triangle with solid fills and a brush

stroke. 

• Intersect: This command results in the

lowest common denominator. Any

portion of any object that does not

overlap all the other objects will be

deleted, with the fill and stroke attrib-

utes of the bottom-most object taking

priority in the final intersected object.

• Punch: The top-most object punches

a hole through everything beneath it.

• Divide: This is the Flash method. All

overlapping paths are cut and closed.

The result is a jigsaw puzzle of pieces

that can be manipulated as you wish.

• Union: All the objects become united

in one contiguous mass. Overlaps are

deleted and the object retains the

attributes of the bottom-most object

in the stack.

• Crop: The top-most object acts as a

cookie cutter and removes everything

outside its shape. The action is the

direct opposite of the Punch function.
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PROBLEM: Clicking anywhere on an

object in FreeHand selects the fill and

stroke of the object; single-clicking on an

object in Flash will select either the stroke

or the fill – double-clicking selects both.

SOLUTION: You’ll

learn to like it. You can

change the width of a

stroke, and the color

of the fill or stroke –

or both – quickly. 
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rom the first day the Internet was

conceived, its primary goal was to allow

people to access information stored on

remote computers. Over the last couple

of years, the technology of Web services

has evolved not only to enhance access-

ing this information, but to share it as

well. 

Web services are in action every-

where. When you see 20-minute delayed

stock quotes on a Web site, or you track

eBay auctions on another, you are most

likely seeing Web services in action. Look

a little further and you’ll find Web servic-

es that can provide these functions as

well as spell checking, address verifica-

tion, ZIP code to city search, and even

validation of e-mail addresses. In this arti-

cle, you’ll see how to access one of these

Web services and display the results on

your own Web site.

Sending e-mail responses to users is

one of the most important services you

can provide to a customer visiting your

site. E-mail is used for sending response

messages, reports, and personal mes-

sages, and almost without exception, any

site that has an online form has a field for

entering an e-mail address. This informa-

tion is, or at least was, one of the hardest

pieces of information to verify. This article

will outline a very simple application of

Web services that will have you verifying

e-mail addresses at time-of-entry in no

time.  

Web Services
Four main components make up a

Web service:

• XML: eXtensible Markup Language

provides a language-neutral format for

exchanging information.

• WSDL: Web Service Definition

Language file in XML format that

describes the Web service.

• SOAP: XML-based messaging frame-

work used for Web services.

• UDDI: standardized directory service

for registering and querying Web ser-

vice meta data.

For this article, I will be concerned

only with the URL location of a single

Web service WSDL file.

WSDL
A WSDL file is an XML file with the fol-

lowing elements:

• <definitions>: Root element specify-

ing namespace definitions for the Web

service.

• <types>: Specifies data type defini-

tions for the messages being

exchanged.

• <message>: Defines the data being

exchanged (input/output).

• <part>: Describes the content of the

message being exchanged, typically

used to name parameters being

passed to the WSDL file.

• <portType>: Defines the operations

the Web service can be called to per-

form. 

• <operation>: Function or operation

that can be performed with the Web

service.

• <input>: Input parameters for the par-

ent <operation>.

• <output>: Output parameters for the

parent <operation>.

• <fault>: Message returned to the par-

ent <operation> in the event of an

error.

• <binding>: Protocol for accessing the

operation described in the

<portType>.

• <service>: Related port definitions.

• <documentation>: Information about

the Web service operations.

• <port>: Endpoint definition for a

<binding> element.

ColdFusion MX has incorporated

three ways to access these WSDL files

(referred to as “consuming a Web serv-

ice”): the <CFINVOKE> tag, the <CFOB-

JECT> tag, and the createObject() func-

tion. This article will focus on using the

<CFINVOKE> tag. Dreamweaver MX also

has a components panel (see Image I)

where you can access various Web servic-

es, view tree diagrams of the WSDL files,

and create code snippets by drag and

drop. 

Since there are numerous documents

describing how to add a Web service to

the component panel, this article will

provide WSDL output file information

directly from the Web service.

cfmx

ColdFusion MX: 
A Web Services Example

Verify e-mail addresses at time-of-entry

by richard gorremans

f
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“In this article, you’ll see how 
to access one of these 

Web services and display the
results on your own Web site”



<CFINVOKE>
The <CFINVOKE> tag provides access

to a registered WSDL component on a

server. This WSDL component can be

written as a ColdFusion Component

(CFC), ASP.NET, SOAP, or in other lan-

guages that are capable of outputting a

WSDL file.

The first attribute of the <CFINVOKE>

tag to be populated is WEBSERVICE. The

value of this attribute is the literal URL of

the WSDL file for the Web service compo-

nent being “consumed.” For this example,

the Web service is located at:

http://soap.einsteinware.com/email/emai

lservices.asmx?WSDL.

The next <CFINVOKE> attribute that

will be populated is METHOD. The value

of METHOD will correspond to the

<part> element used for processing the

request in the WSDL file. Image II shows

that the <part> element is located in the

s:element element and has an attribute

of “ValidateEmailAddress”. The

“ValidateEmailAddress” will be the value

entered for METHOD.

The last attribute that will be populat-

ed for this example is the RETURNVARI-

ABLE. This attribute specifies the name of

the ColdFusion variable that will be pop-

ulated with the result set returned from

the Web service. Image III shows that the

WSDL return values are located in the

simpleType element named “CheckEmail

Result”. The sub-element s:restriction

specifies that the result set will be a

string and the s:enumeration sub-ele-

ments show five possible results.

The possible values that can be

returned are:

• Valid

• InvalidUser

• InvalidAddress

• InvalidServer

• Error

<CFINVOKEARGUMENT>
In some cases, as with the example

shown, the Web service may require

parameters to be supplied. Viewing the

http://soap.einsteinware.com/email/emai

lservices.asmx?WSDL file shows that the

<part> element named “ValidateEmail

Address” has a sub-element

complexType.sequence.element with a

name attribute of “emailAddress” with a

type of string. This is the parameter for

the e-mail address that’s to be verified. 

When parameters are required to be

passed to the Web service you can use

the <CFINVOKEARGUMENT> tag. This tag

has two attributes: “NAME” and “VALUE”.  

The “NAME” attribute, for this exam-

ple, is populated with the name attribute

value from the complexType.sequence

.element element – “emailAddress”.

The “VALUE” attribute is populated

with the e-mail address to be verified.  

You now have code that will “con-

sume” a Web service located on the

Einstein Technologies server that you can

pass an e-mail address, and verify if the e-

mail address:

• Is properly formatted

• Has a valid server

• Has a matching valid user on that server

<cfinvoke

webservice="http://soap.einstein-

ware.com/email/emailservice.asmx?WSDL"

method="ValidateEmailAddress"

returnvariable="aGetXMLValidEmail">

<cfinvokeargument name="emailAddress"

value="#Trim(form.formEmailAddress)#"/

>

</cfinvoke>

Now that you have the code for the

<CFINVOKE> tag completed, the next

step is adding code for getting the e-mail

address (see Image IV for screen print)

that will be sent as the email-

Address parameter. The code used in this

example is shown below:

<hr />

<h1>E-Mail Verification Form<h1>

<hr />

<form name="formEmailSubmit"

im
a

g
e

 I
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action="#CGI.SCRIPT_NAME#"

method="post">

Enter E-Mail Address:

<input type="text" value=""

name="formEmailAddress"

maxlength="254" width="50">

<input type="submit"

name="formSubmit" value="Verify">

</form>

Displaying the Results
The final step is processing the result

set returned from the Web service that

will be stored in the aGetXMLValidEmail

ColdFusion variable created by the

<CFINVOKE> tag. For this example

<CFSWITCH> will be used to display,

dynamically, a “user friendly” message

based on the value of the result set. 

<cfswitch

expression="#aGetXMLValidEmail#">

<cfcase value="Valid">

E-Mail Provided Is Valid

</cfcase>

<cfcase value="InvalidUser">

E-Mail Server is Valid but the User

does not exist.

</cfcase>

<cfcase value="InvalidServer">

E-Mail Server is not valid, cannot

verify E-Mail address 

provided. Please re-enter and try

again.

</cfcase>

<cfcase value="InvalidAddress">

E-Mail provided is not properly for-

matted. Please re-enter and try again.

</cfcase>

<cfcase value="Error">

An error was encountered with the

web service verification.

Please try again later. 

</cfcase>

</cfswitch>

Using the returned result set, a cus-

tom message can be displayed to the

user (see Image V).

Conclusion
Sometime near the start of the

Internet the term “Information Highway”

was coined. Except for a very few, most

drivers on this “Information Highway” got

lost or missed a lot of the wondrous

sights. The biggest problem, in my opin-

ion, was that there were not enough road

signs to indicate what services were avail-

able at the millions of off-ramps.  

My sixth grade teacher, my mentor

even now that she has been gone for

many years, once told me, “The smartest

person in the world is not the one who

knows the most, but the one who knows

where to find the most.” She told me this

the day she took me to the school library,

gave me my first library card, and showed

me how to use the card catalog to locate a

book.

With this article you now have a road

sign that spells out some of the services that

are available on the off-ramp called Web

services. Take the exit, explore the country-

side, and enjoy the wonders and advan-

tages that this article barely touches on.
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doldFusion 

by sarge sargent

dThree years ago, I wrote an article in ColdFusion 

Developer’s Journal discussing how to create customized 

roles-based ColdFusion (CF) authentication (CFDJ, Vol. 2, issue 

3: “Customize ColdFusion Authentication”). The article focused 

on showing how to implement page-level security within 

CF without the pains of setting up Advanced 

Security in ColdFusion 4.5.1. 
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o you remember <CFAUTHENTICATE>,

isAuthorized(), and isProtected(), and

how hard it was to properly configure a

userDirectory? It didn’t even work with

certificates! Well, since Macromedia com-

pletely removed Netegrity’s SiteMinder

and replaced it with the JAAS (Java

Authorization and Authentication

Service) in ColdFusion MX (CFMX), I fig-

ured it’s time to do an update.

If you followed the example in the

first article, or if you just happened to

already roll your own security paradigm

in CF, you were in good shape for the

security changes in CFMX. This is because

you already wrote your own code to per-

form user authentication against some

back-end user database (LDAP, Active

Directory, RDBMS, etc.) and assigned user

roles based on group memberships with-

in the user database. (Code examples for

this article can be downloaded from

www.sys-con.com/mx/sourcec/cfm). 

Additionally, you should have already

coded a mechanism for authorizing

logged-in user access to features and

functionality within your applications. If

you were diligent, you even included

logic to ensure your authentication code

only ran once per user session. CFMX

provides this framework for you with the

CFLOGIN scope and ColdFusion

Components (CFCs).  

Keeping in line with the first article,

the scope of this article also focuses on

user authentication and access at the

page level within a given CFMX applica-

tion. Naturally, this begs questions about

other security concerns such as protect-

ing CF templates with OS-level permis-

sions and integrating CFMX with Web

server access controls (e.g., digest securi-

ty). These are all beyond the scope of

this article but if there’s interest, I will
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cover these and other topics in future

articles. Again, this article will focus on

the basics of using the CFLOGIN scope to

authenticate and authorize users via

CFCs.

User Security Basics
Let’s talk basics. Authentication is the

process of identifying users – that they

are who they say they are. This is typically

performed with a username/password

challenge, but can be as seamless as

using X.509 certificates, or as conclusive

as biometric devices. When answering

the challenge, a query validates the user’s

input against some form of user store:

RDBMS, LDAP, Active Directory, etc.

Authorization is the process of identifying

the rights and permissions of the authen-

ticated user. The user store is also the

deposit for these rights or group mem-

berships.

CFMX provides new tags and func-

tions to control user security. <CFLOGIN>

provides a container for performing user

authentication and authorization and

instantiates the CFLOGIN structure. Code

inside the CFLOGIN tags executes only for

unauthenticated users. The CFLOGIN

structure contains two variables: CFLO-

GIN.name and CFLOGIN.password.

Populate these variables with one of the

following: 

• j_username and j_password form

fields

• username and password values (or

hashes) passed in the Authorization

header in Web Server Authentication

(Basic, NTLM, Digest, etc.)

• setCredentials method of a Flash

Remoting Call

<CFLOGINUSER> identifies (or logs in)

the authenticated user to CFMX. It

requires three parameters: name, pass-

word, and roles. Typically, you pass the

CFLOGIN.name and CFLOGIN.password

values to CFLOGINUSER. The roles attrib-

ute is a comma-separated list of author-

ized application roles. The getAuthUser

function retrieves the CFLOGINUSER

name attribute; the isUserInRole function

confirms whether the user is a member of

the specified role. Finally, <CFLOGOUT>

logs the user out of the CFMX applica-

tion, and destroys all traces of the user’s

ID, password, and roles.

In order to implement page-level

security in CFMX, we need to authenti-

cate the user, figure out the user’s per-

missions, and then check those permis-

sions on protected pages/sections of the

application. We will use a simple login

form to present the authorization chal-

lenge (see Code I). We will code a CFC to

handle the authentication and authoriza-

tion, instantiate the CFC inside the CFLO-

GIN section of the Application.cfm, and

store the authenticated user’s group

memberships (or access levels) within a

session-level structure.  

The Auth CFC
The heart of our security paradigm is

the CFC, so let’s start there. As I said,

authentication and authorization happen

against some sort of user directory. You

pick your poison: LDAP, Active Directory,

RDBMS, NT SAM, etc. To continue in the

spirit of the first article I will use an LDAP

as my user directory. However, this time I

will be using a username/password com-

bination instead of X.509 certificates.

The Auth CFC will have four methods:

init, authenticate, authorize, and

setAuthUser. The init method is a

“default” constructor that returns an

instance of the CFC. It sets some default

LDAP connection values for use by other

methods in the CFC.  You will also notice

the <cfset init()> in the pseudo construc-

tor area – the area after the opening

<CFCOMPONENT> and before the first

<CFFUNCTION>. Since the code in this

area automatically runs upon CFC instan-

tiation, the Init function will fire even

without invocation (see Code II). 

For more information on using the

init method as a constructor, see Rob

Brooks-Bilson’s “Top Ten Tips for

Developing ColdFusion Components” at

www.oreillynet.com/pub/a/javascript/20

03/09/24/coldfusion_tips.html.

Next is the authenticate method. This

method requires two arguments: user-

name and password. Pass these argu-

ments to the Username and Password

<CFLDAP> attributes, providing authenti-

cation to the LDAP.  Upon successful

authentication (i.e., a valid

username/password pair in the LDAP),

the method returns true; otherwise it

returns false. The Boolean values allow

for efficient CFIF evaluations, such as

<CFIF auth.authenticate(#Form.j_user-

name#, #FORM.j_password#)>. (See Code

III.)

The authorize method also requires

the username and password arguments.

Because the username and password are

passed directly to the LDAP, the authorize

method also provides a means of authen-

tication. However, this method returns a

comma-separated list of groups to which

the user belongs (see Code IV). Within

your code – or even at the Web server

level – you can create access control lists

(ACLs) to assign permissions to your

LDAP groups. The application/system

rights and permissions assigned to the

groups extend to its members. These

group memberships are roles within the

CFMX security paradigm.

We now have simple methods for

authentication and authorization within

our application. However, it is not very

efficient to authenticate the user without

retrieving any of his or her attributes

from the LDAP; nor is it efficient to make

two separate CFC calls to build a user

object. The setAuthUser method provides

this functionality. The LDAP query in

setAuthUser provides the same authenti-

cation as the authenticate method, but it

also retrieves useful user attributes and

stores them in a local structure. Next

setAuthUser calls the authorize method

to retrieve the user’s group memberships,

and then adds the returned list to the

local user structure. Finally, setAuthUser

returns the user structure (see Code V).

Notice that I wrap the body of the

methods in Try-Catch blocks. This stan-

dard error-trapping technique provides

valuable debugging information.

<CFLDAP> now retrieves the actual error

returned by the LDAP server instead of

throwing a generic error message. Log

the errors to a customized log file with

<CFLOG>. The <CFTHROW> enables all

<CFCATCH> in calling templates to dis-

play the LDAP error caught in the CFC

method.

The Login Structure
Let’s now turn our attention to the

Application.cfm (see Code VI). First, create

the CFMX Application framework with a
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<CFAPPLICATION> tag. Enable SESSION-

MANAGEMENT and a SESSIONTIMEOUT

(or use the default timeout specified in

the CFMX Administrator). CFMX 6.1 adds

the LOGINSTORAGE attribute to <CFAP-

PLICATION>, which specifies whether to

store the authentication information in a

non-persistent cookie (default) or the

Session scope. Use the default LOGIN-

STORAGE=Cookie for this example. Next,

code some conditional logic to control

user logout. You can do this nicely by

wrapping <CFLOGOUT> in a <CFIF>

block that checks for a URL or FORM vari-

able. You can strengthen the logout by

explicitly clearing the SESSION scope.

The <CFLOGIN>…</CFLOGIN> pro-

vides the security container for process-

ing the authentication code for every

unauthenticated user request.

Performing this authentication only once

during the user’s session is optimal. The

conditional logic forces the user to the

login form if the CFLOGIN scope is not

instantiated. The j_username and j_pass-

word submitted from the loginform.cfm

instantiate the CFLOGIN scope.  

Begin the authentication process by

instantiating the auth.cfc into a shared

scope. The Application scope makes the

most sense because you want the CFC to

persist across user sessions. Use <CFOB-

JECT> or createObject() to instantiate the

CFC instead of <CFINVOKE>. <CFIN-

VOKE> transiently invokes the CFC but

will not persist the instance. Call the

setAuthUser method to authenticate the

user, retrieve the user’s group member-

ships, and build an object containing the

user’s memberships and other LDAP

attributes. Return this object into a

Session-level container for the current

user.

If setAuthUser() is successful, the

Session.User variable will contain the

authenticated object structure, providing

a simple user profile structure that can be

used throughout the site. Now we can

log the user into CFMX with <CFLOG

INUSER>.  Use the CFLOGIN.name and

CFLOGIN.password variables  for the

username and password attribute values.

Pass the Session.User.Group value to the

CFLOGINUSER to authorize the user for

those roles. Then set a Session-level vari-

able that indicates the login status.

The final construct in the CFLOGIN

container is a CFCATCH block that han-

dles any errors in the login process. It is

important to wrap all of the security code

in the Try-CATCH syntax for error control.

The code in this block sets the login sta-

tus indicator to false, creates a login fail-

ure message, and returns the user to the

login form. The CFCATCH.Message will

return any error messages thrown from

the CFC methods.

User Authorization
Now that CFMX has authenticated the

user, and his/her profile information and

group memberships are stored in a

Session-level object, use that information

to provide authorization throughout the

application. Use getAuthUser() to retrieve

the username of the logged-in user.

Implement access control within your

templates by wrapping objects, code, or

even the entire template itself in an IF-

Else block that uses isUserInRole() to

authorize the logged-in user for the pro-

tected functionality. The index.cfm pro-

vides an example of retrieving the

logged in username, displaying the user

profile, and using roles-based authoriza-

tion to display links and/or text (see Code

VII).

Conclusion
Leveraging ColdFusion Components

and the security tags and functions in

ColdFusion MX provides a robust system

for roles-based authentication. Persistent

CFCs provide a layer of abstraction and

code reuse. The CFLOGIN container runs

security code for any unauthenticated

user request, ensuring that the challenge

and authentication of the user happens

only once. The built-in functions allow

granular page-level access control. These

features can augment any existing cus-

tom security logic for your CFMX applica-

tions.

Notes
• CFLOGIN LoginStorage attribute: At

the time of this writing, the CFLOGIN

LoginStorage attribute contains a bug

(53320) when specifying SESSION. This

bug does not completely clear the

internal security scope when logging

out of CFMX via <CFLOGOUT>.

Although the session data is tied to the

logged-in user, the bug results in a

cached user login exposable to the

next user login. This bug does not exist

when using cookies to store the

authentication information.

CFMX uses a base64-encoded string

containing the application name, user-

name, and password as the in-memory

cookie value (CFAUTHORIZATION_

applicationname) sent with every page

request. You may want to consider

using SSL and domain-level cookies to

protect this information, or utilizing

the Session scope to persist this

authentication information. You can

read more about the LOGINSTORAGE

attribute in the CFMX LiveDocs at

http://livedocs.macromedia.com/cold-

fusion/6.1/htmldocs/appsec10.htm.

• CFC Instantiation versus invocation:

The code accompanying this article

uses createObject() to instantiate the

Auth CFC (auth.cfc). It is common prac-

tice for developers to use multiple

CFINVOKE tags to invoke CFC meth-

ods. Accessing CFCs in this manner

does not create a persistent instance of

the CFC, and therefore does not run

the instance data in the CFC pseudo-

constructor. Although this constructor

code is not required to execute the

CFC, it is a best practice to utilize this

area. This is why I advocate the use of

<CFINVOKE> for method invocation of

persistent CFCs instantiated with

createObject() and <CFOBJECT>.

Consult the CFMX LiveDocs for more

details of CFC instantiation and invoca-

tion at http://livedocs.macromedia

.com/coldfusion/6.1/htmldocs/buil-

di10.htm.

• Access control: Most Web servers pro-

vide site and directory-level access

control, requiring user authentication

to access folders or directories con-

taining the Web site files. I am not

privy to native methods of extending

this functionality beyond the template

and/or page level to the elements

within the code (e.g., links, text, vari-

ables, etc). This custom design does

extend the Web server’s own access

control to the element level via CF, uti-

lizing the same user database for

authentication. 
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<html>

<head>

<title>Customized CFMX Authentication</title>

<meta http-equiv="Content-Type" content="text/html;

charset=iso-8859-1">

</head>

<body>

<H2>Please Log In</H2>

<cfoutput><!---#### Display login error message on failure.

####--->

<cfif isDefined('Session.goodLogin') AND NOT

Session.goodLogin><span style="color:##FF0000">#loginmes-

sage#</span></cfif>

<cfform name="LoginForm" action="#CGI.script_name#"

method="post">

<table>

<tr>

<td>username:</td>

<td><cfinput type="text" name="j_username"

required="yes" message="You must enter a username!"></td>

</tr>

<tr>

<td>password:</td>

<td><cfinput type="password" name="j_password"

required="yes" message="You must enter a password!"></td>

</tr>

</table><br>

<input type="submit" value="Log In">

</cfform>

</cfoutput>

<p>&nbsp;</p>

</body>

</html>

<cfcomponent displayname="Auth" hint="Authenticate and

Authorize LDAP users">

<!---#### Psuedo constructor area automatically runs when

component is instantiated. ####--->

<cfset init()>

<!---#### Init function returns an instance of the compo-

nent ####--->

<cffunction name="init" access="public" output="yes"

hint="Initialize this CFC">

<cfargument name="Start" default="dc=macromedia, dc=com"

required="Yes" type="string">

<cfargument name="Server" default="localhost"

required="Yes" type="string">

<cfargument name="Filter" default="uid=*" required="Yes"

type="string">

<cfargument name="Scope" default="SUBTREE" required="yes"

type="string">

<cfargument name="Attributes" default="*" required="no"

type="string">

<cfargument name="Port" default=389 required="no"

type="numeric">

<cfargument name="Sort" default="cn" required="no"

type="string">

<cfargument name="SortCtrl" default="ASC" required="no"

type="string">

<cfargument name="Sep" default="" required="no"

type="string">

<cfargument name="Delimit" default="" required="no"

type="string">

<cfset variables = duplicate(Arguments)>

<cfreturn this />

</cffunction> 

<!---####  Authenticates the user and returns true on suc-

cess, false on failure. ####--->

<cffunction name="authenticate" access="remote" return-

type="boolean" output="No" hint="Performs simple LDAP User

Authentication">

<cfargument name="Username" type="string" required="yes"

default="" hint="Username">

<cfargument name="Password" type="string" required="yes"

default="" hint="User password">

<cftry>

<cfldap action="QUERY" 

name="getLdapUser"

attributes="uid"

start="#variables.Start#"

scope="#variables.Scope#"

filter="uid=#Username#"

server="#variables.Server#"

port="#variables.Port#"

username="uid=#lUsername#,ou=Employees,#variables.Start#"

password="#lPassword#">  

<cfif getLdapUser.RecordCount>

<cfreturn true>

<cfelse>

<cfreturn false>

</cfif>

<!---#### Error Handling: Logs and throws error returned

from LDAP. ####--->

<cfcatch type="any">

<cflog text="Error in auth.cfc method authenticate() -

Error: #cfcatch.message#" type="Error" file="authentication"

application="yes"> 

<cfthrow message="#CFCATCH.Message#">

</cfcatch>

</cftry>  

</cffunction> 

<!---#### Queries LDAP for user group memberships and

returns them as a string if successful.  ####--->

<cffunction name="authorize" access="remote"

returntype="string" output="no" hint="Performs simple LDAP

Group Membership lookup.">

<cfargument name="Username" type="string" required="yes"

default="" hint="Username">

<cfargument name="Password" type="string" required="yes"

default="" hint="User password">

<cftry>

<cfldap action="QUERY"

name="getLdapGroups"

attributes="cn"

start="#variables.Start#"

scope="#variables.Scope#"

filter="(&(objectClass=groupofuniquenames)(uniquemember=uid=

#arguments.Username#*))"

sort="#variables.Sort#"

sortcontrol="#variables.SortCtrl#"

server="#variables.Server#"

port="#variables.Port#"

username="uid=#arguments.Username#, ou=Employees,#vari-

ables.Start#"

password="#arguments.Password#">     
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<cfif getLdapGroups.RecordCount>

<cfset this.roles = valueList(getLdapGroups.cn)>

<cfreturn this.roles>

<cfelse>

<cfreturn> 

</cfif>

<!---#### Error Handling: Logs and throws error returned

from LDAP. ####--->

<cfcatch type="any">

<cflog text="Error in auth.cfc method authorize() -

Error: #cfcatch.message#" type="Error" file="authorization"

application="yes">

<cfthrow message="#CFCATCH.Message#">

</cfcatch>

</cftry>

</cffunction> 

<!---####  Authenticates and Authorizes the user, and

returns a structure containing the user's attributes and

roles. ####--->

<cffunction name="setAuthUser" access="remote"

returntype="struct" output="No" hint="Returns an authenti-

cated LDAP user object.">

<cfargument name="Username" type="string" required="yes"

default="" hint="Username">

<cfargument name="Password" type="string" required="yes"

default="" hint="User password">

<cftry>

<!---####  Authenticates the user and retreives their

attributes. ####--->

<cfldap action="QUERY" 

name="getAuthUser"

attributes="uid, cn, dn, mail, givenName, sn,

telephoneNumber, pager, mobile"

start="#variables.Start#"

scope="#variables.Scope#"

filter="uid=#Username#"

server="#variables.Server#"

port="#variables.Port#"

username="uid=#arguments.username#,ou=Employees,#vari-

ables.Start#"

password="#arguments.password#">

<cfscript>

if (getAuthUser.RecordCount) {

this.siteUser = StructNew();

//Concatenate the User's name from the LDAP attributes

for convenience

StructInsert(this.siteUser, 'Name',

getAuthUser.givenName & ' ' & getAuthUser.sn, True);

attribs = getAuthUser.ColumnList;

//Loop the LDAP results and store them in a user

structure

for (i=0; i LT ListLen(getAuthUser.ColumnList); i =

i+1) {

col = ListFirst(attribs, ',');

val = "getAuthUser."&col;

StructInsert(this.siteUser, col, evaluate(val),

True);

attribs = ListDeleteAt(attribs, 1, ',');

} //END FOR

} //END IF

//Retrieve the user's group memberships and add them to

the siteUser structure

this.roles = authorize(argu-

ments.username, arguments.password);

StructInsert(this.siteUser, 'Groups', this.roles);

return this.siteUser;

</cfscript>

<!---#### Error Handling: Logs and throws error returned

from LDAP. ####--->

<cfcatch type="any">

<cflog text="Error in auth.cfc method setAuthUser() -

Error: #cfcatch.message#" type="Error" file="setAuthUser"

application="yes"> 

<cfthrow message="#CFCATCH.Message#">

</cfcatch>

</cftry>

</cffunction>

<cfsilent><!---#### Remove the white space left by

Application.cfm ####--->

<cfapplication name="CFMXAUTH" sessionmanagement="Yes"

loginStorage="COOKIE">

<!---#### Logout Control: Clear user's Session information

and logout ####--->

<cfif isdefined("form.logout") or isdefined("url.logout")>

<CFLOGOUT>

<cfset StructClear(Session)>

<cflocation url="index.cfm" addtoken="no">

</cfif>

<!---#### Security Container: Only runs if current user is

not logged into CFMX. ####--->

<CFLOGIN>

<!---#### If the CFLOGIN scope is not instantiated, force

user to login. ####--->

<cfif not IsDefined("cflogin")>

<cfinclude template="loginform.cfm">

<cfabort>

<cfelse> <!---#### CFLOGIN instantiated, begin authenti-

cation/authorization code. ####--->

<cftry>

<!---#### Instantiate the component into a shared scope

for reuse. ####--->

<cfscript>

if(not isDefined('Application.ldapLogin')) {

// Create CFC in Application scope if it does not

exist.

Application.ldapLogin = createObject("component",

"auth");

}

// Create Session-level object to hold returned authen-

ticated user object.  

Session.User = Application.ldapLogin.setAuthUser(CFLO-

GIN.name, CFLOGIN.password);

</cfscript>

<cfif isdefined('Session.User')>

<!---#### Log user into CFMX and authorize for specified

roles. ####--->

<CFLOGINUSER name = "#CFLOGIN.name#" password = "#CFLO-

GIN.password#" roles="#Session.User.Groups#">

<!---#### Create Session-level login indicator. ####--->

<cfset Session.goodLogin = true>

</cfif>

<!---#### Trap any errors, including those thrown by the

CFC methods. ####--->

<cfcatch type="any">
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<cfset Session.goodLogin = false>

<!---#### Login message to display on login form. ####--

->

<cfset loginmessage = "Invalid Login: " &

CFCATCH.Message>

<cfinclude template="loginform.cfm">

<cfabort>

</cfcatch>

</cftry>

</cfif>

</CFLOGIN>

<!---#### Additional CFML here. ####--->

<cfset Request.DSN = "test">

</cfsilent>

<html>

<head>

<title>Customized CFMX Authentication</title>

<meta http-equiv="Content-Type" content="text/html;

charset=iso-8859-1">

<style type="text/css">

.Normal {

font-family: Arial, Helvetica, sans-serif;

font-size: 11 pt; font-weight: normal; color: #000000; 

}

.header { 

font-family: Verdana, Arial, Helvetica, sans-serif;

font-size: 11 pt; font-weight: bold; color: #000000; 

} 

.Tasks {

font-family: Verdana, Arial, Helvetica, sans-serif;

font-size: 10 pt;

}

</style>

</head>

<body class="Normal">

<cftry><!---#### Display currently logged in Username and

Roles ####--->

<cfoutput><p>Welcome! You are currently logged in as <span

style="color:##00CC66;">#GetAuthUser()#</span> with the fol-

lowing roles: <span

style="color:##00CC66">#SESSION.User.Groups#</span></p></cfo

utput>

<table width="*" border="0" cellpadding="5" cellspacing="3">

<tr>

<td class="Tasks" width="25%" valign="top">

<span class="header">Task Menu</span><br>

<a href="index.cfm">Personal Page</a><br>

<!---#### Check Roles for permission to view ####--->

<cfif isUserInRole("Engineers")>

<a href="index.cfm">Basic User Tasks</a><br>

</cfif>

<cfif isUserInRole("ColdFusion")>

<a href="index.cfm">ColdFusion Product Support</a><br>

</cfif>

<cfif isUserInRole("Professional Services")>

<a href="index.cfm">Professional Services</a><br>

</cfif>

<cfif isUserInRole("Managers")>

<a href="index.cfm">Manager's Task List</a><br>

</cfif>

<p><a href="index.cfm?logout=true">Log out</a></p>

</td>

<td width="*">

<cfoutput><table width="*" border="1" summary="User

Info">

<caption class="Tasks">#SESSION.User.Name# <span

style="font-size: 8 px">(#Session.User.DN#)</span></caption>

<tr>

<th scope="row">Firstname</th>

<td>#Session.User.Givenname#</td>

</tr>

<tr>

<th scope="row">Lastname</th>

<td>#Session.User.sn#</td>

</tr>

<tr>

<th scope="row">UserID</th>

<td>#Session.User.uid#</td>

</tr>

<tr>

<th scope="row">Dept.</th>

<td>#ReplaceNoCase(Session.User.Groups, ",", ", ",

"ALL")#</td>

</tr>

<tr>

<th scope="row">Email</th>

<td>#Session.User.mail#</td>

</tr>

<tr>

<th scope="row">Phone</th>

<td>#Session.User.telephonenumber#&nbsp;</td>

</tr>

<tr>

<th scope="row">Cell</th>

<td>#Session.User.mobile#&nbsp;</td>

</tr>

<tr>

<th scope="row">Pager</th>

<td>#Session.User.pager#&nbsp;</td>

</tr>

</table></cfoutput>

</td>

</tr>

</table>

<cfcatch>

<cfdump var="#CFCATCH.Message#">

<p><a href="index.cfm?logout=true">Log out</a><br></p>

</cfcatch>

</cftry>

<cfdump var="#Session.User#">

</body>

</html>
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n my last article (MXDJ, Vol. 2, issue

2), we looked at how Macromedia

Director is extensible, primarily

through Xtras (plug-ins); and that

there are four major types of Xtras –

Scripting/Lingo Xtras, Sprite Xtras,

Transition Xtras, and Tool Xtras.

Now it’s time to look specifically at

what’s involved in rolling your own Xtra.

A full treatment of all the ins and outs,

gotchas and nuances of writing Xtras is

unfortunately beyond the scope of this

article (indeed, it would fill a small book),

but we do have enough space to start to

show you how to write a basic Scripting

Xtra.

A Scripting Xtra (they used to be

called Lingo Xtras) allows you to call

C/C++ functions from within Lingo. You

commonly call them in one of two ways –

the first by instantiating the Xtra, as in:

infile =new(xtra "fileio")

which returns an instance you can work

with. Alternatively, you can create a glob-

al command that you can just invoke

from Lingo, no instantiating involved, as

in:

printMyFile("filename")

If such a command existed, you could

just use it directly, no objects to fiddle

with, no muss, no fuss. Although the

global commands might seem less trou-

blesome to use, and are easier for begin-

ners, the instantiation method is actually

more powerful, because each instance

can carry along its own set of internal

variables. Thus, in our FileIO usage exam-

ple above (FileIO is an Xtra that comes

with Director for reading and writing text

files), you can open up multiple

instances, one for an input file, one for an

output file, and so on, and each instance

will keep track of its own internal data.

On Windows, Xtras are really .DLLs

with a special entry point; you compile

them in Visual C. The Macintosh is similar,

but on the Mac they’re code fragments.

CodeWarrior is used for compiling on the

Mac. 

To write an Xtra, you should really be

familiar with C/C++. Some people have

experimented with writing Xtras in other

languages like Delphi and Visual Basic,

but the developer’s kit assumes you’re

using C/C++ and adapting it to other lan-

guages isn't trivial. Speaking of the devel-

oper’s kit, you will need one. It’s called

the XDK (Xtras Developer’s Kit) and it’s

free. You get it from Macromedia at their

website – just search for XDK. There are

XDKs for various products, such as

Authorware, but in this article we will

focus on writing an Xtra for Director.

The XDK for Windows has no binaries,

just header files. The XDK for Macintosh

now has some special binaries for Carbon

development that will need to be includ-

ed in your projects. The XDK includes

both examples and template projects. For

reasons of space, we’ll simply focus on

Windows in this article.

You should unpack the XDK onto your

hard drive. I usually make the version of

the XDK part of the filepath, as XDKs dif-

fer with successive releases. The current

XDK is for Director 8.5 (yes, it lags behind

the product release) and I use a folder

named \XDK_D85. Within that folder will

be a folder named INCLUDE, which will

need to be in your compiler’s include

path; a folder called DOCS made up of

.HTM files documenting the API; and a

folder called EXAMPLES.

The Examples folder is subdivided

into sections relating to each of the dif-

ferent common Xtra types. We’ll be look-

ing in the Examples\Script folder. That

folder is further divided into DrAccess,

Skeleton, Skeleton2, and valueChecker.

Of these, DrAccess and valueChecker are

actual examples and Skeleton and

Skeleton2 are the templates that you can

base your project on.

Of the skeletons, Skeleton is the older

style template, with multiple files. In

Skeleton2, the template has been

reduced from five files to two (it’s the sec-

ond version of the skeleton). In fact,

Skeleton itself has undergone significant

changes since the early releases, but it is

only with Director 8.5 that the slimmer

Skeleton2 has been introduced. In this

article, though, we will use the original

Skeleton; that way if you’re writing an

Xtra for Director 8, which only supports

the original Skeleton, you won't be lost.

To begin, copy the files from the

skeleton to wherever you want to be

working. For example, C:\XTRASDEV

\MYXTRA\, copying the winproj and

source subfolders. You will have five

source files:

• CREGSTER.CPP

• CREGSTER.H

• CSCRIPT.CPP

• CSCRIPT.H

• XTRA.CPP

If you choose to open up the project

SCRIPT.DSW (on Windows) you will want

to remove the listed source files from the

workspace and reimport them. The rea-

son for this is that they won’t point to

your source files in your new location,

and it’s just easier to reimport them.

Make sure to import the .DEF file as

found in your WinProj folder. Failure to

import this file means that the Xtra will

compile but will be ignored by Director

when you go to run Director. It will seem

as if it didn’t exist.

Now is also a good time to correct

your project settings. In the Link settings

I like to compile the Xtra directly into the

xtras

Architecting with Director

Writing Xtras

by tab julius

i
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Director Xtras folder (it makes debugging

much easier than compiling to one place

and copying it over). In the Preprocessor

settings for the C/C++ language I usually

correct the search path to be ..\source

because the project folder is one folder

over from the source folder; and I correct

the path to the XDK Include folder

because I don’t compile from within the

Xtras folder and the path is relative to the

examples. 

Now you can work on the files them-

selves. As I mentioned, there are five files

in the original version of the skeleton.

The first, Xtra.cpp, mainly concerns itself

with versioning. You can put your version

numbers here, but for now we’ll leave it

alone. You won’t have to touch it for this

example.

The CREGSTER files control the regis-

tration aspect of loading an Xtra. When

Director starts up, the runtime Xtra looks

in the Xtras folder for any Xtras and

queries them to see what kind of Xtra

they are and what capabilities they pos-

sess. This is the point at which the Xtras

register themselves, and is where the

CREGSTER files come into play.

For a scripting Xtra, there are three

things you need to do with the CREGIS-

TER files. The first is in CREGSTER.H. You

must generate a GUID for the registration

class. Each class has a GUID, or unique

identifier. You need to have unique iden-

tifiers for each class, and to generate a

new set for every Xtra you write; failure

to do so will cause Director to complain

that it has duplicate Xtras in its folder.

GUIDs are generally a combination of

your Ethernet address from your network

card and a date/time stamp. Visual C

comes with a utility in its BIN folder called

GUIDGEN.EXE; you can run this program,

make a GUID, and copy it into your source

file.

CSCRIPT.H and CREGSTER.H both

have sections where they want a GUID,

and you have to give them different ones.

Look in each .H file for a line that says 

#error PLEASE DEFINE A NEW CLSID

Although we haven’t gotten to

CSCRIPT.H in this discussion yet, I usually

create both my GUIDs at the same time

just because it’s quicker.

To make a GUID, run GUIDGEN.EXE,

choose the format of GUID that says

DEFINE_GUID(...), and then press the

Copy button to copy the GUID to the

clipboard. You can then paste that into

the .H file. To make a second one, press

New GUID and then Copy again. When

you paste, the number will come in like:

// {A53645A1-557D-11d8-9F02-

0010B53FC39F}

DEFINE_GUID(<<name>>, 

0xa53645a1, 0x557d, 0x11d8, 0x9f, 0x2,

0x0, 0x10, 0xb5, 0x3f, 0xc3, 0x9f);

You will need to replace <<name>>

with CLSID(CRegister) in CREGSTER.H and

CLSID(CScript) in CSCRIPT.H. Then you

your GUIDs will be defined for the CScript

class and the Cregister class. 

This is a good time to point out that

all of the example files have a comment

at the top that says “How to Customize

This File” and tells you to rename the file,

adjust the included filename references

accordingly, rename all the classes to be

the name of your class, and so on. I can

tell you that the easiest thing to do is to

not bother with any of that. I used to

spend all sorts of time renaming and cus-

tomizing and realized it was not only a

huge waste but prone to error as well.

Now I just use the default file names and

classes and it works just fine. As

long as you keep your Xtras in

separate folders, which is a good

idea anyway, you won’t run into

trouble.

There isn’t anything else in

CREGSTER.H that you have to

bother with in a scripting Xtra.

There are no class instance vari-

ables here that you would nor-

mally set up. So, the next stop is

CREGISTER.CPP.

There are only two things

you’ll probably need to do in

CREGSTER.CPP, at least for a

scripting Xtra. One is that if you

intend for your Xtra to run in

Shockwave, you will have to

declare it as “Safe for

Shockwave”. Declaring it as safe

doesn’t make it so, it just tells

Shockwave that you say it is so,

and Shockwave will allow the

Xtra to load. It is your responsi-

bility to make sure that the Xtra

does not allow Shockwave

access to the user’s machine

without their knowledge in any

way that could violate their

security, data integrity, or privacy.

If you do want to declare it as Safe for

Shockwave you’ll need to incorporate

Code I into the CRegister_IMoaRegister::

Register function, just after the section

that registers the method/message table

– generally the last block of code before

the return code.

You may or may not need the

#define’s depending on what version of

the XDK you have. If the compiler com-

plains they’re already defined, comment

them out.

Defining Your 
Message Table

The message table is where the fun

starts. This is where you get to declare

the commands your Xtra will support.

In the original skeleton the method

table appears about halfway through

the file (you can’t miss it). The format of

the message table is something like

Code II.

You can see many examples of mes-

sage tables by using PUT in the message

window to put the interface for other

scripting Xtras (in Director MX you can

use the third-party scripting Xtras button

SHOW THE WORLD

“We don’t have a lot of time to write down
documentation...but with Camtasia Studio, we
can document our software with video tutorials.”
—Fred Shepardson, PhD, Mathematician, Management Consultant

www.techsmith.com/mxdev
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of any application.
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xile written & illustrated by louis f. cuffari 4

on the message window to do the same

thing). 

If you look at the second line of the

sample table above, you’ll see where it

says xtra MyXtra. That declares the inter-

nal name of the Xtra to be “MyXtra”. Thus,

when you instantiate it, or put the inter-

face out to the message window for it,

you’ll refer to it as xtra “MyXtra”, as in:

put interface(xtra "MyXtra")

Note that in the message table there

are no quotes around the name itself, but

there are when the command is issued

from the message window.

After the declaration of the name

of the Xtra you can have comments –

multiple comments if you wish – then

you define the commands. There is

always a “new” command, but after that

you can have one or more of your own

defined commands. This example

defines two. You can follow each com-

mand with a comment describing the

command, although I don’t often do

this on Xtras with lots of functions lest I

run past the maximum string space

(remember, the message table is a

string, just a big one).

Commands preceded by “*” are global

commands, meaning you can just issue

them from Lingo without instantiating

anything. Commands without the aster-

isk (like the “new” command shown) are

child commands and must be tied to an

instance, meaning that you must instanti-

ate the Xtra before you issue a call to that

function.

After the command name, you can

optionally allow parameters to be passed

in. Specify the type that is required and

Lingo will do basic validation during a

call to make sure that the right type is

passed in. For instance, you could specify

integer, integer, string, and Lingo would

require the user to pass in two integers

and a string; otherwise, it would throw an

error. The argument types are integer,

float, string, symbol, object, any, and *;

the asterisk is a wild card, allowing any

number of arguments, of any type. If

used, it should be the last entry on the

line.

Optionally, you can have names with

each arg, to make it easier for the user, as

shown in the FixCertainBug example; or

you can omit the names and just have

the arg types.

Type Any is used to allow any type –

not restricted – but it’s also used to allow

types that aren’t listed. For instance, if

you wanted to pass down a member

spec (e.g., member 8 of castlib 1), it won’t

officially be an integer, float, string, etc.

For a parameter like that you would use

Any to allow it in.

If you required a minimum of four

parameters, the third of which can be of

any type, you could do: 

FixCertainBug integer, string, any,

string, *

Lingo will only allow that call to go

through if the user supplies at least four

parameters, the first of which is an inte-

ger, and the second and fourth of which

are strings. Note that Lingo will do as

much validation as it can for you, but if

you use Any or * you will be responsible

for validating those parts when called, to

make sure that you got what you wanted

from the user.

Child functions (that must be instanti-

ated) must always have an object type as

the first parameter, as in:

"myChild object me, string

newName\n"

The Enum Table and
CSCRIPT.H

When your Xtra is invoked from Lingo

you will be called through the function

::Call, and passed in a number that tells

you which command from your message

table was invoked. New (the first com-

mand) is always #0; in the example mes-

sage table, FixAllBugs would be #1 and

FixCertainBug would be #2, etc.

It’s easy to introduce bugs if you’re

just checking by number. If you were to

move commands around in the table

you’d have to reorder all your code. To

keep problems to a minimum, the Xtras

use an enum table, found in CSCRIPT.H,

that looks like:

enum

{

m_new =0,

m_fixAllBugs,

m_fixCertainBug,

m_XXXX

};

With such a table, all you have to do

Tab Julius has been

writing software since

the mid-70's, and now

works for a software

firm developing med-

ical imaging applica-

tions, although he still

does limited consult-

ing on the side.

tab@penworks.com
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is make sure the order of enums in the

enum table matches the order of com-

mands in the message table. If you move

them around in the message table, you

must do so in the enum table. If you

delete, or comment out, entries in the

message table, you must make the corre-

sponding changes in the enum table. As

long as they’re in sync, things will work.

If you forget to make an entry, or change

an entry, then you’ll find your program

executing one command when you

intended for it to execute another. The

m_XXXX entry at the end serves no pur-

pose other than to let you keep a

comma at the end of all of your entries,

without having to remember to add or

remove commas when moving enums

around.

Class Instance Variables
Any variables your Xtra wants to keep

around between calls should be kept in

the Class Instance Variable section in

CSCRIPT.H, rather than using globals. If

your Xtra is instantiated, then the vari-

ables here are specific to each instance. If

you don’t instantiate your Xtra and just

use global Lingo commands, they’ll still

work – they’ll just apply to the one “glob-

al instance” of the Xtra. You only need to

use true global, non-class instance vari-

ables if there’s something you need to

share between instances, although this

practice is discouraged.

Here's Where It All Happens
Let’s turn our attention to

CSCRIPT.CPP, which is where the guts of

the Xtra will be. There are three parts you

need to concern yourself with:

1. The ::Call function, which is the main

entry point for the Xtra, where you will

test for how your Xtra was called and

react accordingly.

2. Any individual functions you wish to

set up. Although you could do all your

work in the ::Call function, typically

developers use ::Call simply as a dis-

patcher and make a corresponding

function for each command supported

by the Xtra.

3. The Create/Destroy method, which is

where you will typically acquire (or

free) any interfaces you need – and

you will typically need a few – as well

as where you will initialize your

instance variables.
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// SAFE FOR SHOCKWAVE.

#define kMoaMmDictKey_SafeForShockwave "safeForShockwave"

#define kMoaMmDictType_SafeForShockwave kMoaDictType_Bool

MoaBool bItsSafe = TRUE;

/* Mark the xtra as safe for Shockwave */

if (err == kMoaErr_NoErr)

{

err = pRegDict->Put(kMoaMmDictType_SafeForShockwave,

&bItsSafe, sizeof(bItsSafe), kMoaMmDictKey_SafeForShockwave);

}

Code II

static char msgTable[] = {

"xtra MyXtra\n" \

"-- www.penworks.com\n"

"—- by Tab Julius <tab@penworks.com>\n"

"--\n"

"new object me\n"

"* FixAllBugs         -- Magically fix all bugs\n"

"* FixCertainBug integer bugNum, string fixName\n"

};

Code III

STDMETHODIMP CScript_IMoaMmXScript::Call(PMoaMmCallInfo callPtr)

{

/* variable declarations */

MoaError err = kMoaErr_NoErr;

switch( callPtr->methodSelector ) 

{

case m_new:

/*

* --> insert additional code -->

*/

break;

case m_fixAllBugs:

err = XScrpFixAllBugs(callPtr);

break;

case m_fixCertainBug:

err = XScrpFixCertainBug(callPtr);

break;

break;

}

return(err);

}

Code IV

MoaError CScript_IMoaMmXScript::XScrpFixAllBugs(PMoaDrCallInfo callPtr)

{

UNUSED(callPtr);

MoaError err = kMoaErr_NoErr;

MessageBox(NULL, "Hello, World", "", MB_OK);

return(err);

}
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Each function you make will have a

corresponding prototype; on some ver-

sions of the XDK the prototypes are kept

in CSCRIPT.H, in other versions they are at

the top of CSCRIPT.CPP. In the D8.5 XDK

they are in CSCRIPT.H – look for the sec-

tion EXTERN_BEGIN_DEFINE_

CLASS_INTERFACE for CScript, which

declares Call as a public interface and

then lists XScriptGlobalHandler,

XScriptParentHandler, and

XScriptChildHandler prototypes. These

are examples only of Global/Parent/Child

handlers, and the names are not a

requirement. In fact, I would delete them

and replace them with the equivalent

XScriptFixAllBugs, XScriptFixCertainBug,

etc.

In CSCRIPT.CPP you will find the cor-

responding functions near the top of the

file – again, replace the names with the

names of your functions and delete the

ones you’re not using. Make them match

your prototypes.

At this point, the only major thing

left to do is to tweak the ::Call function

so that it invokes the functions proper-

ly. It will still be necessary to access

the args passed in, and learn how to

return values, and so forth, but we’ll

have to defer that part until next time.

For the moment we’ll get it up and

limping, and get it to say “Hello World”,

which is enough to claim victory for

now.

As I mentioned, when someone calls

a function in your Xtra, the ::Call function

is invoked. For our example, the ::Call

function should end up looking like Code

III.

The whole flow of events is now in

place. The message table lists two com-

mands besides New – fixAllBugs and

fixCertainBug. FixAllBugs takes no

parameters. The enum table lists three

enums, one for New and one each for

m_fixAllBugs and m_fixCertainBug.

When the user invokes FixAllBugs(), that

will be found as the second entry (0-

based) in the message table, or rather

the first one after New (0). Since the

entries in the enum table are in the

same order as those in the message

table, m_FixAllBugs has an internal

value of 1. This is how it’s supposed to

work, because when ::Call is invoked it is

passed callPtr, which has a field,

methodSelector, that has a value of 0..n,

up to the number of entries in your

message table less one. The net effect is

that by syncing an enum table to your

message table, you can respond with

mnemonic enum names, not by keep-

ing track of index numbers into the

table.

The code in ::Call will switch to the

case statement for m_fixAllBugs, which

will invoke XScrpFixAllBugs. If you then

modify the function XScripFixAllBugs

you can complete the cycle (see Code

IV).

Compile it, and you now can restart

Director. If everything is in your favor, the

Xtra will be loaded, you can issue the

command fixAllBugs() from either the

message window or from a script, and a

“Hello World” message box should pop

up!

Conclusion
Next time we’ll take a closer look at

how parameter passing works, how to

return data back to Director, and what

gotchas to look out for; and we’ll take a

peek at some of the MOA (Macromedia

Open Architecture) classes. Until then,

enjoy! 

The History panel makes it really easy

to build commands that automate particu-

larly tedious or common tasks. The process

of creating a Command file with the

History panel is fairly straightforward: clear

the History panel so you can start fresh. 

Now perform a sequence of actions in

the Flash MX 2004 IDE that you want to

use regularly. Select the group of actions

you performed in the History panel and

then click the disk icon in the bottom

right-hand corner. Enter a name for your

command and then click the OK button.

You now have a new command in

your Commands menu that when select-

ed will execute and perform that particu-

lar sequence of actions. The .jsfl file has

been created for you and saved into the

correct directory, such that it is displayed

in the Commands menu.

There are technical limitations with

the History panel; some of the interac-

tions you make with the Flash MX 2004

IDE cannot be replayed. As you play

around, you will notice that certain

actions contain a red cross. These are the

actions that cannot be replayed.

But it doesn’t stop there; the History

panel can also display the JSFL actions

required to perform a particular interaction

within the Flash MX 2004 IDE. This comes in

handy when trying to learn how to make

Flash do something with the JSAPI. So, for

example, if you want to know which func-

tion to use to add a new layer to the current

timeline using JSFL, you can tell the History

panel to expose the function calls, by

changing the view settings (see Image VII). 

Then you can manually add a new

layer to the timeline, which will add a

new action to the list in the History panel

(see Image VIII).

You can then copy that function call

by right-clicking the selected actions and

selecting to Copy Steps (see Image IX).

You now have the JSFL code in your

clipboard, which you can then paste

directly into any text editor.

Flash Panels
As I mentioned in the introduction, it is

possible to add new panels to the Flash

MX 2004 IDE. You can create your own

panel by simply creating a Flash movie and

then saving it into the correct directory.

The panel can be opened by selecting

it from the Window>Other Panels menu.

The name associated with the panel you

have created and thus displayed in the

Other Panels menu is simply the name of

the .swf file you placed in the WindowSWF

directory. When you select your panel

from the menu, your Flash movie is auto-

matically displayed inside a panel, and the

size of the panel is automatically deter-

mined by the size of your Flash movie. 

I’ve created a Flash movie and named

it Auto Save.swf. I then save that Flash

movie into the WindowSWF directory.

The next time I restart Flash MX 2004, a

new option has appeared in the Other

Panels menu.

When I select the new Auto Save

option, a new panel opens that contains

my Flash movie.

ActionScript and JSFL
Flash movies that run in the Flash MX

2004 IDE can execute a string of JSFL

–continued from page 31
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using a special ActionScript function. This

means that your Flash Panels and XML2UI

dialog boxes that contain Flash movie

controls can modify/update the Flash

document from a Flash movie. The JSFL

code you execute can also return a value

back to ActionScript. The ActionScript

function is called MMExecute, and it can

be used anywhere in your Flash movie.

The syntax is simple:

MMExecute("yourStringOfJSFL");

I can create a new panel, as above,

and in the Flash movie for that panel I

can execute a string of JSFL that will

delete a layer when a button is pressed.

This would be achieved with the  follow-

ing ActionScript:

MyButton.addEventListener("click",this

)

This.click=function()

{

MMExecute("flash.getDocumentDOM().getT

imeline().deleteLayer();")

}

When the button is pressed, the

MMExecute function passes the JSFL

string passed as an argument to the Flash

MX 2004-JSAPI Interpreter, which then

runs the JSFL code in exactly the same

way that a command is run.

It’s also possible to access the value of

a JSFL property due to the fact that the

MMExecute function will return a value,

so if I wanted to check that the computer

that is running my Flash panel is currently

connected to the Internet, I could use the

following ActionScript:

HasInternetConnection=MMExecute("flash

.isConnectedToInternet");

In the above code, the ActionScript

variable “hasInternetConnection” will

contain a Boolean value, which was

received from the JSAPI Interpreter.

MMExecute will wait for a return value

before it runs the next line of code in your

ActionScript. It is recommended that if you

want to execute a large JSFL script from

ActionScript, you place the JSFL script in a .jsfl

file and then use the “flash.runScript”func-

tion to execute the JSFL script within that file. 

Here is an ActionScript function that

will execute the JSFL code within a .jsfl file:

function

executeLargeJSFLScript(fileURI)

{

return

MMExecute("fl.runScript(‘"+fileURI+"’)

;")

} 

And you can use it like this:

executeLargeJSFLScript("file:///C:/mys

cript.jsfl");

Notice that the fileURI in the above

example doesn’t contain back slashes, it

contains forward slashes and a file:///

protocol prefix. 

The following would be incorrect:

executeLargeJSFLScript("C:\myscript.js

fl");

This is a common mistake. All the

functions exposed to us in our JSFL

scripts that accept a fileURI as an argu-

ment, such as “flash.saveDocumentAs”,

require the string to contain a file:/// pro-

tocol prefix and to contain forward slash-

es instead of back slashes.

One really useful implementation of

MMExecute would be if you wanted a

Flash movie running in the Flash MX 2004

IDE to work with regular expressions. As

ActionScript doesn’t support regular

expressions, it’s possible to send them

the JSAPI Interpreter using MMExecute,

and the return value(s) will be returned

to ActionScript.

That should be enough to get you

started. Part 1 of this article covered a

general introduction to the extensibility

layer, and discussed the fundamental

Document Object Model and the rela-

tionship between different parts of a

Flash document and their associated

objects. It introduced the new Flash

JavaScript Editor in Flash MX 2004 along

with the History panel, and showed you

how to build your own Flash panels.

When developing Flash extensions, it is

sometimes neessary to provide a dialog

box, which prompts the user to make a

choice or customize settings of exten-

sions in an intuitive and user-friendly

way. In Part 2 we'll take an in-depth look

at XML2UI - Flash Dialog Boxes.

im
a

g
e

 V
II

im
a

g
e

 V
im

a
g

e
 V

I
im

a
g

e
 V

II
I

im
a

g
e

 I
X

Guy Watson (aka FlashGuru) has been a well-

recognized figure in the Flash community for

around four years, supporting the community

with tutorials and source files, moderating the

large Flash community forums, and running his

own Flash resource Web site – FlashGuru’s MX

101. Guy was one of the two developers that

created the award-winning zoom interface for

Relevare and now works for Endemol UK, the

creative force behind reality television, produc-

ing programs such as Big Brother and The

Salon. Guy spends most of his time developing

Flash games and applications for high-profile

clients such as Channel 5 Television,

Ladbrookes, and UK Style.

guy@flashguru.co.uk



62 • MXDJ.COM 3 • 2004



3 • 2004 MXDJ.COM • 63



64 • MXDJ.COM 3 • 2004

In this article we will combine three

cool tools and use them to create

another tool that we can use like any

other in Director. Not only will it take a

mere half hour to create, but it will save

you hours of development time in the

future (see Image I) This probably

sounds confusing so let me be more

specific: I’m talking about creating a

behavior.

Behaviors
Behaviors are one of the most power-

ful tools in Director because they allow

you to create generic code snippets that

can be utilized in many different situa-

tions and projects. To show you what a

behavior is, let’s create a simple one.

Open the script window and set the

script type to “behavior” in the property

inspector. Now, add a property to the

script:

property pName

Properties are variables that are

accessible in every handler throughout

the entire behavior script, but they

belong to that specific behavior so they

are not global. That means you can

have properties with the same name in

different behaviors and they will not

overwrite each other, as globals would

do.

A behavior really consists only of

properties and handlers. As with the

properties, the handlers are not global

but belong to the behavior script, so you

cannot call a handler in a behavior like a

movie script. Let’s add a handler to the

behavior we just created:

on mouseDown (me)

put "My name is:" && pName

end mouseDown

Now the behavior can react to a

“mouseDown” event. But how does the

behavior get this event? This is where

sprites come into play. Create a button

cast member (or bitmap, text, or any

other type of sprite you like) and drag it

onto the stage. Now drag your behav-

ior script onto the sprite on the stage.

Run the movie, click on the sprite, and

watch the message window:

-- "My name is: "

The sprite gets the “mouseDown”

event from Director because you clicked

on it. Because it has a behavior with a

handler that reacts to this event, the han-

dler is executed and you see the output.

The only problem is that the property

pName does not have any value yet.

That’s where the cool part of behaviors

needs to be explained – the

getPropertyDescriptionList()handler. This

handler is called when you drag the

behavior onto the sprite or when you

click the behavior “parameters” button in

the property inspector. It’s used to assign

default property values to the behavior.

In this case we want to give the property

pName a value. In order to do that the

handler needs to return a property list in

a specific format that contains all of the

needed information to generate a behav-

ior dialog for the user to input the prop-

erty values to be used by the behavior

instance. Take a look at the handler for

our simple example behavior:

on getPropertyDescriptionList ()

im
a

g
e

 I



3 • 2004 MXDJ.COM • 65

p = [#pName: [#comment: "Name",

#format: #string, #default: ""]]

return p

end getPropertyDescriptionList

The property pName has a descrip-

tion (#comment), a format (#string), and

a default value in case the user does not

type anything into the behavior dialog.

To see the dialog simply drag the behav-

ior onto the sprite and you will be

prompted to input a value for the name

property. Now type a name, hit enter,

and run the movie again. When you click

on the sprite again, the message win-

dow will output the value you just

entered:

-- "My name is: Woody"

But the real beauty of behaviors will

become obvious in a second. Create a

second sprite on the stage and drag the

same behavior onto the sprite. Now

type another name into the behavior

dialog field, run the movie again, and

click on the first and then the second

sprite:

-- "My name is: Woody"

-- "My name is: Allen"

The secret behind this is that you

just created two totally independent

instances of the same behavior from

one behavior script, doing nothing

but drag and drop. The behavior script

is like a blueprint from which behavior

instances are created when you drag

the script onto a sprite, much like

sprites are instances of cast members

you drag onto the stage. The behavior

instances don’t know about each

other, and they don’t share any values

or handlers since they only belong to

the sprite they are assigned to and

only receive messages from that

sprite.

But what if you wanted to call a func-

tion of the behavior from somewhere in

your movie, say from a movie script or

from the message window? There are

two commands in Lingo that let you do

exactly that:

sendSprite(1, #reportName)

sendAllSprites(#reportName)

These commands send the message

to either a single sprite or all sprites in

the current frame. They don’t call the

handler of the sprite, they just send a

message to the sprite. If the sprite has a

handler with that name, it will automati-

cally call that handler. If the sprite does

not have a handler with that name or

does not have a behavior at all, nothing

will happen – the sprite will just ignore

the message. So if you are not sure which

channel your sprite is in or you want to

send a message to all sprites, you can use

sendAllSprites.

Let’s add another handler to the

example behavior to test this functionali-

ty:

on reportName (me)

put "My name is:" && pName

end reportName

As in the mouseDown handler before,

the “me” Keyword after the handler name

is a reference to the behavior instance

and is always required in behavior scripts.

(See the “me” entry in your Lingo diction-

ary for further explanations.)
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Now you can call the handler by

sending a message to all sprites from the

message window:

sendAllSprites(#reportName)

-- "My name is: Woody"

-- "My name is: Allen"

Now you know almost everything

there is to know about creating and

working with behaviors. But if you’re still

not really sure what behaviors are, look at

the behaviors that come with Director

and check out some of the demo movies.

In this article, we’re going to create a

behavior that uses two other great func-

tionalities in Director. The first one is

called “Imaging Lingo”. While this sounds

a little scary at first, it’s really nothing

more than a set of relatively simple Lingo

commands that give you access to

Director’s internal sprite-rendering

engine. That means you can create new

or manipulate existing bitmap images in

Lingo.

Image Objects
When talking about images it’s

important to know that Director has an

internal object type called “image”, which

is pretty much what you’d expect it to be

– an image. Cast members like bitmaps,

but text members also have an “image”

property that stores a pointer to the

internal image object of that cast mem-

ber. Create a new bitmap or text mem-

ber and try to get its image into the mes-

sage window:

put member("my picture").image

-- <image:23cdb4>

What you see is the reference to the

image object in Director’s memory. It

looks complicated, but trust me, it really

isn’t.

You can manipulate that image, copy

it, or create a new image from scratch

using the “image()” function and assign

the new image to the member’s image

property. Try the following in the mes-

sage window:

myMember = new(#bitmap)

Director created a new bitmap cast

member for you in the current cast

library. Open the new cast member in the

paint window by double clicking it and

type the following two commands in the

message window:

myMember.image = image(100, 100, 16)

myMember.image.fill(0, 0, 100, 100,

rgb(255,0,0))

The paint window will now show a

red square. The same thing that happens

when you use the tool in the paint win-

dow to draw a square box just happened

because of these two lines of Lingo code.

You told Director to create a new

100x100 pixel, 16-bit image object, and

assigned the new member’s image prop-

erty to it. In the next line you filled the

whole rect of the image (0,0,100,100)

with the color red (rgb(255, 0, 0)). See

how easy it is to work with image

objects?

Imaging Lingo really opens up a

whole new world for the Director devel-

oper. If you haven’t learned about this

exciting functionality I recommend read-

ing a good Director book or a few of the

various online articles on the topic.
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Timeout Objects
On to the next step. To complete our

toolbox, we add another great functional-

ity that Director has offered since version

8: the “timeout” object. Like image objects

this is also an internal object, and behaves

a little like a virtual metronome. It can

send out messages on time intervals that

are defined when you create the object. 

I know this sounds a little confusing,

but once you get to know timeout

objects, you’ll realize that there’s really

nothing complicated about them. It’s

really easy to create one:

t = timeout("My Timeout").new(1000,

#helloWorld)

This creates a new timeout object

with the name “My Timeout”, stored in

the variable t. The first parameter sets the

interval and the second parameter

defines the name of the function to be

called. After the timeout object has been

created it starts to do what it’s told to do

automatically. In this case it calls the

function “helloWorld” every second (1000

milliseconds).

You can easily test it for yourself; just

create a new movie script and write a

simple “helloWorld” function:

on helloWorld

put "Hello World"

end helloWorld

Start the movie and see how the

timeout object calls your function by

watching its output in the message win-

dow. 

That’s pretty much all there is to know

about working with timeout objects.

Some of the functions and properties of

timeout objects will be covered later.

The Goal
Now that we have our tools, let’s

define what we’ll build using them. In

many projects, especially games, you can

see some sort of a graphical timer that

displays the amount of time passed or

remaining. For example, in a game you

might see a timer bar on top that shows

the time left for you to shoot all of your

enemies, or in an online learning applica-

tion you might see the time passed since

you started the session. 

These time displays make a nice addi-

tion to many applications. They’re much

nicer than simply displaying numbers

and they can be used in a broad variety

of colors or shapes. But as a requirement,

since we’re talking about displaying

something as constant as time, they need

to indicate the passing of time independ-

ent of the movie’s frame tempo. While

scientists could well argue that time

indeed isn’t constant at all, we’ll just

assume it is because we’re going to cre-

ate a multimedia application, not the

navigation system for the next Mars mis-

sion.

Timeout objects send their messages

based on the interval they were given

when they were created. The frame

tempo of your movie does not influence

their behavior at all, so you can have your

movie running at 1 or 30 frames per sec-

ond and the timeout object will send a

message every second if you tell it to do

so.

One important thing to know about

timeout objects is that if you specify

very short intervals, such as 1 or 10 mil-

liseconds, Director in some cases might
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not be able to send out a message at

every interval because other tasks, like

rendering the stage, might take too

much time, so there’s not enough pro-

cessing time left to send out the mes-

sage. In that case the message will be

dropped and, hopefully, at the next

interval a message will be sent. So if you

know there are many things to be ani-

mated on the stage, set the timeout

interval to something Director can man-

age. In most cases you will not need

such very short intervals anyway, so

don’t worry about it.

The Behavior
We’re going to create a behavior that

uses Imaging Lingo and Timeout objects

to display a graphical timer bar based on

input defined in the behavior’s property

settings dialog. The cool thing about this

behavior will be that by changing the

behavior’s properties you can create an

unlimited amount of different timer dis-

plays. Curious? Let’s start.

We’ll begin by defining the behav-

ior’s properties. Take a look at the com-

ments describing the properties; most

of it should be pretty self-explanatory,

and the rest will be made clear in the

process.

Properties
• property pSprite: Timer sprite

• property pMem: Member to draw the

image in

• property pOrigImage: Original image

of the member

• property pImage: Current image of

the timer

• property pDuration: Duration of

timer in seconds

• property pCurrentTime: Elapsed time

in seconds

• property pInterval: Timer update

interval

• property pOnDigit: Image “on” digit

• property pOnDigitColor: On-digit

color

• property pOnDigitWidth: On-digit

width

• property pOnDigitHeight: On-digit

height

• property pOffDigit: Image “off” digit

• property pOffDigitColor: Off-digit

color

• property pOffDigitWidth: Off-digit

width

• property pOffDigitHeigh: Off-digit

height

• property pIncRect: Rect of increment

image

• property pGap: Gap between the dig-

its

• property pOrientation: Orientation

(horizontal/vertical)

• property pDirection: Direction of

movement (up/down)

• property pAutoStart: Auto start

• property pCall: Lingo call when fin-

ished

• property pTimer: Timeout object

Some of these properties will be set

through the property setting dialog. (If

you don’t know what the getProperty-

DescriptionList handler does, please read

up on it in the Lingo dictionary and

Director manuals.)

Now that all of the properties are

defined and we know how most of them

are set, let’s start with the internal events

and how our sprite reacts to them (see

Image III).

The beginSprite handler is always a

great place to do all or most of the initial-

izations of your behaviors since it is called

automatically when the playback enters

the frame where the sprite is started. The

same goes for the endSprite handler,

since this event is also automatically

called when the playback head leaves the

sprite.

The sprite initialization here is really

simple. In order to save some typing

work, we store a reference to the sprite

object and its member in properties. In

order to be able to restore the image of

the sprite’s member, we copy the cur-

rent image using the duplicate() func-

tion. (Note: Using member(n).image

always returns a reference to that image,

so any manipulation of that image will

be reflected in the original cast mem-

ber.) 

The timer bar will be constructed by

two images, an “on” and an “off” digit.

Each digit will have four properties: color,

width, height, image. These properties

are stored in a property list to make it

easier to access them. The color, width,

and height of each digit will be set

through the property description dialog

(see above); the image will be assigned in

a minute, so for now we’ll just set it to 0.

After the properties are set, the han-

dler calls two custom initialization han-

are one of the
most powerful

tools in Director because they allow you to create
generic code snippets that can be utilized in many
different situations and projects”

are one of the
most powerful

tools in Director because they allow you to create
generic code snippets that can be utilized in many
different situations and projects”
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dlers. The first one, initDigits(), creates the

images of the “on” and “off” digits; the

second, initTimer() handler, creates the

timer bar image and starts the display.

Let’s look at these two handlers:

-- init the digits

on initDigits (me)

-- create "on" digit

me.createDigit(pOnDigit)

-- create "off" digit

me.createDigit(pOffDigit)

end initDigits

This handler calls another function to

create each digit (see Image IV). The func-

tion expects the property list with the

information about color, width, and

height of the timer digit; it creates a new

image in the given dimensions, fills it

with the desired color, and stores it in the

“image“ property of the list:

-- create a digit image

on createDigit (me, myProps)

-- create image and fill with given

color 

myImg = image(myProps.width,

myProps.height, 16)

myImg.fill(myImg.rect,

myProps.color)

myProps.image = myImg

end createDigit

The initTimer () handler is very similar.

It calls a function to create the timer bar

image, resets the pCurrentTime property,

and if needed, starts the display of the

timer (see Code II).

The creation of the timer is based on

three things: the orientation of the timer

(horizontal, vertical), the direction of the

movement of the timer animation (up,

down), and the images of the digits we

just created (see Code III).

The timer orientation determines the

total width and height of the display,

based on the width and height of the

digits and the amount of time set in the

properties. Depending on the direction in

which the animation moves, the “on” or

“off” digits will then be copied into the

timer image. After the image is created

we just need to update the member’s

image so the timer will be displayed in

the sprite on the stage:

-- update the member image

on updateImage (me)

pMem.image = pImage

--pMem.centerRegPoint = TRUE

pMem.regpoint = point(0,0)

end updateImage

Depending on how you want the

timer to be aligned with other elements

on the stage, you can set the regpoint

to point(0,0) or center it. It’s really a per-

sonal choice and something that can be

changed by uncommenting a single

line, so don’t worry about it at this

point.

Hard to believe, but that’s almost it.

We really have only one final handler left

to build to manipulate the display of the

timer (see Code IV).

This handler draws the image of a sin-

gle digit (“on” or “off”) into the timer
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image, so it’s basically our animation han-

dler. The direction property defines

which way the timer animates; the

elapsed time property helps us find the

location of the current digit in the timer

image. After the image is altered, we just

need to call the updateImage () handler

again and the changes will be reflected

on the stage.

All that is left now is to write a couple

of handlers to control the timer from the

outside. That’s where the Timeout object

we mentioned earlier comes into play

(see Code V).

Before we create a new timeout

object, we check whether there already is

a timeout object so we wouldn’t have to

create a new one. The timeout object we

create will call the mStepTimer () handler;

using the “me” keyword we tell the time-

out to look for the handler in this behav-

ior instance. The calls interval was set

through the behavior description dialog.

If there already is a timeout object, we

activate it by setting its “period” property

manually.

Everything that has a start also has an

end, so we not only want to be able to

start the timer, but also to pause or to

stop it:

-- pause the timer

on mPauseTimer (me)

if objectP(pTimer) then

-- pause the timeout object

pTimer.period = 0

end if

end mPauseTimer

This handler simply sets the timeout

object’s “period“ property to 0 and keeps

it from calling the handler it’s told to call.

This is a neat trick to pause a timeout

object without having to destroy the

object altogether. 

This is done in the mStopTimer han-

dler. The timeout object’s internal “for-

get()“ method is called to deconstruct

the timeout object and the property is

set to VOID to ensure that no reference is

left.

-- stop the timer

on mStopTimer (me)

if objectP(pTimer) then

-- forget the timeout and reset

the property

pTimer.forget()

pTimer = VOID

end if

end mStopTimer

In some cases you might want not

only to start, pause, and stop the timer,

but also to reset it, so a running timer is

stopped and restarted. That can be done

by combining two already existing func-

tions:

-- reset the timer

on mResetTimer (me)

-- make sure the timer is stopped

me.mStopTimer()

-- re-initialize the timer

me.initTimer()

end mResetTimer

on beginSprite (me)
-- store sprite and member
pSprite = sprite(me.spritenum)
pMem = pSprite.member
-- store original image of the member
pOrigImage = pMem.image.duplicate()
-- create property list with on-digit information
pOnDigit = [#color: pOnDigitColor, #width: pOnDigitWidth,

#height: pOnDigitHeight, #image: 0]
-- create property list with off-digit information
pOffDigit = [#color: pOffDigitColor, #width:

pOffDigitWidth, #height: pOffDigitHeight, #image: 0]
-- initialize the timer digits
me.initDigits()
-- initialize the timer
me.initTimer()

end beginSprite

on endSprite (me)
-- restore original image of the member
pMem.image = pOrigImage

end endSprite

Code II
-- init the timer display
on initTimer (me)

-- create timer image
me.createTimer()

-- reset elapsed time
pCurrentTime = 0

-- start timer if autostart flag is true
if pAutoStart then 

me.mStartTimer()
end if

end initTimer

-- create the timer image
on createTimer (me)

-- check the orientation of the timer
case pOrientation of

#horizontal:
-- calculate the width based on digit width, duration

and gap
myWidth = (pOnDigit.width * pDuration) + (pGap *

(pDuration-1))
myHeight = pOnDigit.height
pIncRect = rect(pOnDigit.width + pGap, 0,

pOnDigit.width + pGap, 0)

#vertical:
-- calculate the height based on digit height, dura-

tion and gap
myWidth = pOnDigit.width
myHeight = (pOnDigit.height * pDuration) + (pGap *

(pDuration-1))
pIncRect = rect(0, pOnDigit.height + pGap, 0,

pOnDigit.height + pGap)

end case

-- create the timer image
pImage = image(myWidth, myHeight, 16)

-- check the direction the timer is moving
case pDirection of

#up:
mySrcImg = pOffDigit.image

#down:
mySrcImg = pOnDigit.image

end case

-- copy the digits into the timer image
repeat with i = 1 to pDuration

mySrcRect  = mySrcImg.rect
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See how nice it is to create reusable

code? Not only does it save you a huge

amount of work, it also enables you to

build new functionalities with already

existing code.

Okay, we’re almost done now. If

you’re still with me, you probably already

know what’s missing. I’m talking about

the mStepTimer handler we used in the

creation of the timeout object to call the

animation functions of our behavior (see

Code VI).

The handler increments the internal

counter pCurrentTime and calls the

drawTimerStep () handler to draw the

next digit into the timer image. If the

timer has finished with its animation, the

mStopTimer () handler is called to stop

the timer and destroy the timeout

object. If there is a Lingo function you

want to call after the timer has done its

job, it will be called using the “do” com-

mand.

Now you can control the behavior

from anywhere in your movie by simply

calling these handlers using

sendAllSprites or sendSprite if you have

more than one timer display on the

stage:

sendAllSprites(#mStartTimer)

sendAllSprites(#mPauseTimer)

sendAllSprites(#mStopTimer)

sendAllSprites(#mResetTimer)

Conclusion
That’s it, you did it. It doesn’t look

like much and it really isn’t (see Image

V). The real beauty of these few lines of

code will be revealed once you start

using the behavior. Create a new

bitmap cast member, insert a 1x1 pixel

dot as a dummy image, and drag the

cast member to the stage. Assign the

behavior to the sprite, set the proper-

ties, and start the movie. After playing

with the properties for a while, you will

see how many variations of timer dis-

plays are possible with this simple

behavior. You can create more cast

members, have 10 or more different

timers on the stage at the same time,

and control them with a single call.

To give you a small idea of what you

can do to extend the functionality of this

behavior, here’s a handler to set the

image of the “on” or “off” digits of the

behavior from the outside:

-- set digit image

on mSetDigit (me, myDigit, myImage)

case myDigit of

#on:

if ilk(myImage, #image) then

pOnDigit.image = myImage

end if

#off:

if ilk(myImage, #image) then

pOffDigit.image = myImage

end if

end case

end mSetDigit

You can use existing images of your

application or game for the timer display

or even change the digits while the ani-

mation is running. The number of possi-

ble extensions is really up to your imagi-

nation.

You can view and download a demo

movie, including the source files, at

www.sys-con.com/mx/sourcec.cfm.
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myDestRect = mySrcRect + (pIncRect * (i-1))
pImage.copyPixels(mySrcImg, myDestRect, mySrcRect)

end repeat

-- update the member image
me.updateImage()

end createTimer

Code IV
-- draw a single step of the timer
on drawTimerStep (me)

-- check the direction the timer is moving
case pDirection of

#up:
mySrcImg = pOnDigit.image
mySrcRect = mySrcImg.rect
myDestRect = mySrcRect + (pIncRect * (pCurrentTime -

1))
#down:

mySrcImg = pOffDigit.image
mySrcRect = mySrcImg.rect
myDestRect = mySrcRect + (pIncRect * (pDuration -

pCurrentTime))
end case

-- copy the new digit into the timer image
pImage.copyPixels(mySrcImg, myDestRect, mySrcRect)

-- update the member image
me.updateImage()

end drawTimerStep

Code V
-- start the timer
on mStartTimer (me)

-- check if there is already a timeout object

if NOT(objectP(pTimer)) then

-- create a new timeout object to animate the timer

pTimer = timeout("Graphical Timer - Sprite " &

me.spritenum).new(pInterval, #mStepTimer, me)

else

-- start a paused timer

pTimer.period = pInterval

end if

end mStartTimer

-- timer animation step

on mStepTimer (me)

-- increment elapsed time

pCurrentTime = pCurrentTime + 1

-- draw current step

me.drawTimerStep()

-- check if animation has finished

if pCurrentTime >= pDuration then

-- stop the timer

me.mStopTimer()

-- call Lingo function

if pCall <> "" then

do pCall

end if

end if

end mStepTimer
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